BroadSoft® Guide

Copyright Notice

Copyright © 2019 BroadSoft, Inc.

All rights reserved.

Any technical documentation that is made available by BroadSoft, Inc. is proprietary and confidential and is considered the copyrighted work of BroadSoft, Inc.

This publication is for distribution under BroadSoft non-disclosure agreement only. No part of this publication may be duplicated without the express written permission of BroadSoft, Inc., 9737 Washingtonian Boulevard, Suite 350, Gaithersburg, MD 20878.

BroadSoft reserves the right to make changes without prior notice.

Trademarks

Any product names mentioned in this document may be trademarks or registered trademarks of BroadSoft or their respective companies and are hereby acknowledged.

This document is printed in the United States of America.
<table>
<thead>
<tr>
<th>Release</th>
<th>Version</th>
<th>Reason for Change</th>
<th>Date</th>
<th>Author</th>
</tr>
</thead>
<tbody>
<tr>
<td>10.0.0</td>
<td>1</td>
<td>Created document for Release 10.0.0.</td>
<td>December 21, 2012</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>10.0.0</td>
<td>1</td>
<td>Edited and published document.</td>
<td>December 31, 2012</td>
<td>Patricia Renaud</td>
</tr>
<tr>
<td>10.0.1</td>
<td>1</td>
<td>Added more frequently asked questions (FAQ) entries.</td>
<td>January 25, 2013</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>10.0.1</td>
<td>1</td>
<td>Edited and published document.</td>
<td>February 6, 2013</td>
<td>Patricia Renaud</td>
</tr>
<tr>
<td>10.0.2</td>
<td>1</td>
<td>Added information on new features.</td>
<td>March 25, 2013</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>10.0.2</td>
<td>1</td>
<td>Edited changes and published document.</td>
<td>March 27, 2013</td>
<td>Jessica Boyle</td>
</tr>
<tr>
<td>10.0.3</td>
<td>1</td>
<td>Added text and Quick Reference Guide information. Removed Leopard support.</td>
<td>April 30, 2013</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>10.0.3</td>
<td>1</td>
<td>Added more text based on comments and revised terminology.</td>
<td>May 9, 2013</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>10.0.3</td>
<td>1</td>
<td>Edited changes and published document.</td>
<td>May 13, 2013</td>
<td>Jessica Boyle</td>
</tr>
<tr>
<td>10.0.3</td>
<td>2</td>
<td>Modified system requirements.</td>
<td>May 16, 2013</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>10.0.3</td>
<td>2</td>
<td>Edited changes and published document.</td>
<td>May 21, 2013</td>
<td>Jessica Boyle</td>
</tr>
<tr>
<td>10.0.4</td>
<td>1</td>
<td>Made modifications to section 37 System Requirements.</td>
<td>June 26, 2013</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>10.0.4</td>
<td>1</td>
<td>Edited changes and published document.</td>
<td>June 26, 2013</td>
<td>Joan Renaud</td>
</tr>
<tr>
<td>10.1</td>
<td>1</td>
<td>Added text on dual screens for desktop sharing and added information on the new features, such as Xtended Services Interface (Xsi) mid-call controls.</td>
<td>August 14, 2013</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>10.1</td>
<td>1</td>
<td>Edited and published document.</td>
<td>August 21, 2013</td>
<td>Andrea Fitzwilliam</td>
</tr>
<tr>
<td>10.1</td>
<td>2</td>
<td>Updated image and removed redundant text.</td>
<td>August 30, 2013</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>10.1</td>
<td>2</td>
<td>Edited changes and published document.</td>
<td>September 4, 2013</td>
<td>Andrea Fitzwilliam</td>
</tr>
<tr>
<td>10.1</td>
<td>3</td>
<td>Added text for the login dialog and keyboard shortcuts.</td>
<td>October 12, 2013</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>10.1</td>
<td>3</td>
<td>Edited changes and published document.</td>
<td>October 22, 2013</td>
<td>Patricia Renaud</td>
</tr>
<tr>
<td>10.1.2</td>
<td>1</td>
<td>Made minor modifications.</td>
<td>October 24, 2013</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>10.1.2</td>
<td>1</td>
<td>Edited changes and published document.</td>
<td>October 31, 2013</td>
<td>Patricia Renaud</td>
</tr>
<tr>
<td>Release</td>
<td>Version</td>
<td>Reason for Change</td>
<td>Date</td>
<td>Author</td>
</tr>
<tr>
<td>---------</td>
<td>---------</td>
<td>-----------------------------------------------------------------------------------</td>
<td>-----------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>20.0.0</td>
<td>1</td>
<td>Added new images and described new features: Security Classification, Call and Chat Recording, Attended Transfer, Call Pull, Call Park/Retrieve, Chat Room Moderation, and headset support.</td>
<td>November 25, 2013</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>20.0.0</td>
<td>1</td>
<td>Edited changes and published document.</td>
<td>December 18, 2013</td>
<td>Patricia Renaud</td>
</tr>
<tr>
<td>20.0.0</td>
<td>2</td>
<td>Modified text in section 7.3 Answer Call.</td>
<td>January 10, 2014</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>20.0.0</td>
<td>2</td>
<td>Edited changes and published document.</td>
<td>January 10, 2014</td>
<td>Joan Renaud</td>
</tr>
<tr>
<td>20.0.1</td>
<td>1</td>
<td>Modified section 12 Communications History for presence-enabled contacts.</td>
<td>January 16, 2014</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>20.0.1</td>
<td>1</td>
<td>Edited changes and published document.</td>
<td>February 7, 2014</td>
<td>Joan Renaud</td>
</tr>
<tr>
<td>20.0.1</td>
<td>2</td>
<td>Modified text in section 7.11 Call Park and Retrieve.</td>
<td>February 12, 2014</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>20.0.1</td>
<td>2</td>
<td>Edited changes and published document.</td>
<td>February 12, 2014</td>
<td>Patricia Renaud</td>
</tr>
<tr>
<td>20.0.2</td>
<td>1</td>
<td>Modified icons in section 3 Get Started.</td>
<td>March 10, 2014</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>20.0.2</td>
<td>1</td>
<td>Edited changes and published document.</td>
<td>March 28, 2014</td>
<td>Joan Renaud</td>
</tr>
<tr>
<td>20.0.2</td>
<td>2</td>
<td>Added more headsets to the supported list. Edited table in section 3 Get Started.</td>
<td>April 2, 2014</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>20.0.2</td>
<td>2</td>
<td>Added more headsets to the supported list.</td>
<td>April 9, 2014</td>
<td>Joan Renaud</td>
</tr>
<tr>
<td>20.1.0</td>
<td>1</td>
<td>Added text about new features: echo service, forced logout, integrated call window, configurable left pane order, silent dialing into Meet-Me conference, flexible contact card configuration, and add-in enhancements. Added Outlook 2013.</td>
<td>April 24, 2014</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>20.1.0</td>
<td>1</td>
<td>Edited changes and published document.</td>
<td>April 29, 2014</td>
<td>Joan Renaud</td>
</tr>
<tr>
<td>20.1.1</td>
<td>1</td>
<td>Added text about Plantronics Spokes installation to section 38 Troubleshooting.</td>
<td>July 28, 2014</td>
<td>Veli-Pekka Heinonen</td>
</tr>
</tbody>
</table>

20.1.1
<table>
<thead>
<tr>
<th>Release</th>
<th>Version</th>
<th>Reason for Change</th>
<th>Date</th>
<th>Author</th>
</tr>
</thead>
<tbody>
<tr>
<td>20.1.1</td>
<td>1</td>
<td>Edited changes and published document.</td>
<td>July 29, 2014</td>
<td>Joan Renaud</td>
</tr>
<tr>
<td>20.2.0</td>
<td>1</td>
<td>Added text about new features: Meet-Me moderator controls and active communications extra buttons. Added text for call recording and voice mail. Updated image and updated text for preferences.</td>
<td>September 12, 2014</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>20.2.0</td>
<td>1</td>
<td>Edited changes and published document.</td>
<td>September 24, 2014</td>
<td>Joan Renaud</td>
</tr>
<tr>
<td>20.2.0</td>
<td>2</td>
<td>Made editorial changes and added clarification about My Room Invitation.</td>
<td>October 9, 2014</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>20.2.0</td>
<td>2</td>
<td>Edited changes and published document.</td>
<td>October 9, 2014</td>
<td>Joan Renaud</td>
</tr>
<tr>
<td>21.0.0</td>
<td>1</td>
<td>Modified document template to accommodate new corporate identity. Added text about new features: Team Telephony, Executive-Assistant, Emergency Call Address Change Service (ECACS), and guest client. Added text about calling name lookup for incoming calls. Modified preferences test to reflect new tab.</td>
<td>December 8, 2014</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>21.0.0</td>
<td>1</td>
<td>Updated the BroadSoft legal notice. Edited changes and published document.</td>
<td>December 22, 2014</td>
<td>Joan Renaud</td>
</tr>
<tr>
<td>21.0.0</td>
<td>2</td>
<td>Added copyright text, added note about contact list size and Feature Access Codes during calls, and escape in full screen video.</td>
<td>January 5, 2015</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>21.0.0</td>
<td>2</td>
<td>Edited changes and published document.</td>
<td>January 20, 2015</td>
<td>Joan Renaud</td>
</tr>
<tr>
<td>21.1.0</td>
<td>1</td>
<td>Added a Table of Figures. Edited changes and published document.</td>
<td>March 31, 2015</td>
<td>Joan Renaud</td>
</tr>
<tr>
<td>21.1.0</td>
<td>2</td>
<td>Changed text for My Room, dial pad, audio devices, multi-device chat, and profile edit. Added a note about OS X ambient noise reduction. Made editorial changes. Removed Appendix B.</td>
<td>April 30, 2015</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>Release</td>
<td>Version</td>
<td>Reason for Change</td>
<td>Date</td>
<td>Author</td>
</tr>
<tr>
<td>---------</td>
<td>---------</td>
<td>------------------------------------------------------------------------------------</td>
<td>-----------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>21.1.0</td>
<td>2</td>
<td>Added Appendix G: Acronyms and Abbreviations. Edited changes and published document.</td>
<td>May 6, 2015</td>
<td>Joan Renaud</td>
</tr>
<tr>
<td>21.2.0</td>
<td>1</td>
<td>Added information on new features: visual voice mail, share passing, Microsoft Skype for Business (S4B) support, call center support, and presence rules. Changed wording for presence table and made corrections after review. Added a note about window management. Updated guest client system requirements and headset list.</td>
<td>May 18, 2015</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>21.2.0</td>
<td>1</td>
<td>Edited changes and published document.</td>
<td>June 30, 2015</td>
<td>Joan Renaud</td>
</tr>
<tr>
<td>21.2.0</td>
<td>2</td>
<td>Added information about limits for active communication sessions.</td>
<td>July 3, 2015</td>
<td>Petri Somerkari</td>
</tr>
<tr>
<td>21.2.0</td>
<td>2</td>
<td>Edited changes and published document.</td>
<td>July 3, 2015</td>
<td>Joan Renaud</td>
</tr>
<tr>
<td>21.3.0</td>
<td>1</td>
<td>Changed the application name, added text about new features, and updated system requirements for new application name and logo.</td>
<td>December 14, 2015</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>21.3.0</td>
<td>1</td>
<td>Edited changes and published document.</td>
<td>December 16, 2015</td>
<td>Joan Renaud</td>
</tr>
<tr>
<td>21.3.3</td>
<td>1</td>
<td>Updated document for Release 21.3.3.</td>
<td>March 24, 2016</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>21.3.3</td>
<td>1</td>
<td>Edited changes and published document.</td>
<td>March 24, 2016</td>
<td>Joan Renaud</td>
</tr>
<tr>
<td>21.4.0</td>
<td>1</td>
<td>Added new features and text about headsets.</td>
<td>April 4, 2016</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>21.4.0</td>
<td>1</td>
<td>Edited changes and published document.</td>
<td>April 27, 2016</td>
<td>Joan Renaud</td>
</tr>
<tr>
<td>21.5.0</td>
<td>1</td>
<td>Added information about new features and made some text enhancements.</td>
<td>June 2, 2016</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>21.5.0</td>
<td>1</td>
<td>Edited changes and published document.</td>
<td>July 21, 2016</td>
<td>Joan Renaud</td>
</tr>
<tr>
<td>21.5.2</td>
<td>1</td>
<td>Modified system requirements and made editorial changes.</td>
<td>October 26, 2016</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>21.5.2</td>
<td>1</td>
<td>Edited changes and published document.</td>
<td>October 31, 2016</td>
<td>Joan Renaud</td>
</tr>
<tr>
<td>21.6.0</td>
<td>1</td>
<td>Added new features.</td>
<td>November 23, 2016</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>21.6.0</td>
<td>1</td>
<td>Edited changes and published document.</td>
<td>December 21, 2016</td>
<td>Joan Renaud</td>
</tr>
<tr>
<td>21.6.0</td>
<td>2</td>
<td>Added notes.</td>
<td>January 2, 2017</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>22.0.0</td>
<td>1</td>
<td>Added new features and made edits.</td>
<td>March 22, 2017</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>Release</td>
<td>Version</td>
<td>Reason for Change</td>
<td>Date</td>
<td>Author</td>
</tr>
<tr>
<td>---------</td>
<td>---------</td>
<td>-----------------------------------------------------------------------------------</td>
<td>-----------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>22.0.0</td>
<td>1</td>
<td>Edited changes and published document.</td>
<td>March 31, 2017</td>
<td>Joan Renaud</td>
</tr>
<tr>
<td>22.0.1</td>
<td>1</td>
<td>Added a note about Lightweight Directory Access Protocol (LDAP) credentials.</td>
<td>April 18, 2017</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>22.0.1</td>
<td>1</td>
<td>Edited changes and published document.</td>
<td>May 19, 2017</td>
<td>Joan Renaud</td>
</tr>
<tr>
<td>22.1.0</td>
<td>1</td>
<td>Added notes and new features.</td>
<td>May 30, 2017</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>22.1.0</td>
<td>1</td>
<td>Edited changes and published document.</td>
<td>June 27, 2017</td>
<td>Joan Renaud</td>
</tr>
<tr>
<td>22.2.0</td>
<td>1</td>
<td>Added new functionality and notes.</td>
<td>August 2, 2017</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>22.2.0</td>
<td>1</td>
<td>Re-organized section 1 Summary of Changes.</td>
<td>September 28, 2017</td>
<td>Joan Renaud</td>
</tr>
<tr>
<td>22.2.1</td>
<td>1</td>
<td>Added a note about external web collab window.</td>
<td>November 9, 2017</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>22.2.1</td>
<td>1</td>
<td>Edited changes and published document.</td>
<td>November 14, 2017</td>
<td>Patricia Renaud</td>
</tr>
<tr>
<td>22.3.0</td>
<td>1</td>
<td>Added new features and notes.</td>
<td>November 23, 2017</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>22.3.0</td>
<td>1</td>
<td>Edited changes and published document.</td>
<td>December 29, 2017</td>
<td>Patricia Renaud</td>
</tr>
<tr>
<td>22.3.2</td>
<td>1</td>
<td>Added a note about S4B submenu and minimizing behavior. Added more information on moderated My Room.</td>
<td>February 21, 2018</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>22.3.2</td>
<td>1</td>
<td>Edited changes and published document.</td>
<td>February 22, 2018</td>
<td>Patricia Renaud</td>
</tr>
<tr>
<td>22.4.0</td>
<td>1</td>
<td>Added Release 22.4.0 enhancements.</td>
<td>March 20, 2018</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>22.4.0</td>
<td>1</td>
<td>Edited changes and published document.</td>
<td>March 28, 2018</td>
<td>Joan Renaud</td>
</tr>
<tr>
<td>22.4.0</td>
<td>2</td>
<td>Added notes.</td>
<td>April 12, 2018</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>22.4.0</td>
<td>2</td>
<td>Edited changes and published document.</td>
<td>April 24, 2018</td>
<td>Joan Renaud</td>
</tr>
<tr>
<td>22.5.0</td>
<td>1</td>
<td>Added new features and edits.</td>
<td>May 31, 2018</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>22.5.0</td>
<td>1</td>
<td>Edited changes and published document.</td>
<td>June 27, 2018</td>
<td>Joan Renaud</td>
</tr>
<tr>
<td>22.5.3</td>
<td>1</td>
<td>Added new features and made edits.</td>
<td>August 16, 2018</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>22.5.3</td>
<td>1</td>
<td>Edited changes and published document.</td>
<td>August 30, 2018</td>
<td>Joan Renaud</td>
</tr>
<tr>
<td>22.6.0</td>
<td>1</td>
<td>Added new features and made edits.</td>
<td>September 3, 2018</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>22.6.0</td>
<td>1</td>
<td>Edited changes and published document.</td>
<td>October 11, 2018</td>
<td>Patricia Renaud</td>
</tr>
<tr>
<td>22.6.1</td>
<td>1</td>
<td>Added notes.</td>
<td>October 15, 2018</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>Release</td>
<td>Version</td>
<td>Reason for Change</td>
<td>Date</td>
<td>Author</td>
</tr>
<tr>
<td>---------</td>
<td>---------</td>
<td>---------------------------------------------</td>
<td>-----------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>22.6.1</td>
<td>1</td>
<td>Edited changes and published document.</td>
<td>October 25, 2018</td>
<td>Patricia Renaud</td>
</tr>
<tr>
<td>22.7.0</td>
<td>1</td>
<td>Added notes and new features.</td>
<td>November 13, 2018</td>
<td>Veli-Pekka Heinonen</td>
</tr>
<tr>
<td>22.7.0</td>
<td>1</td>
<td>Edited changes and published document.</td>
<td>January 8, 2019</td>
<td>Joan Renaud</td>
</tr>
</tbody>
</table>
# Table of Contents

1 **Summary of Changes** .................................................................................................................................................. 14
   1.1 Changes for Release 22 ............................................................................................................................................. 14
   1.2 Changes for Release 21 ............................................................................................................................................. 17
   1.3 Changes for Release 20 ............................................................................................................................................. 21
   1.4 Changes for Release 10 ............................................................................................................................................. 23
2 **About Communicator for Desktop** .......................................................................................................................... 25
3 **Get Started** ................................................................................................................................................................. 26
   3.1 Installation ................................................................................................................................................................. 26
   3.2 Sign In ........................................................................................................................................................................ 26
   3.3 Main Window .............................................................................................................................................................. 27
   3.4 Communications View ............................................................................................................................................... 30
   3.5 Start Chat ................................................................................................................................................................. 31
   3.6 Send File ................................................................................................................................................................. 31
   3.7 Send Email .............................................................................................................................................................. 31
   3.8 Make Audio or Video Call ........................................................................................................................................ 31
   3.9 Share Your Application or Desktop ......................................................................................................................... 32
   3.10 Active Communications .......................................................................................................................................... 32
   3.11 My Room ................................................................................................................................................................. 33
      3.11.1 Select Audio Devices ...................................................................................................................................... 33
4 **Contacts** ........................................................................................................................................................................ 35
   4.1 Add ............................................................................................................................................................................... 35
   4.2 Edit .............................................................................................................................................................................. 36
   4.3 Filters ......................................................................................................................................................................... 36
5 **Presence** ......................................................................................................................................................................... 37
   5.1 Automated Presence .................................................................................................................................................... 38
6 **Chat** ................................................................................................................................................................................ 39
   6.1 Chat View ................................................................................................................................................................. 39
   6.2 File Transfer .............................................................................................................................................................. 39
   6.3 Group Chat ............................................................................................................................................................... 40
   6.4 Chat Recording .......................................................................................................................................................... 40
7 **Audio and Video Calls** .................................................................................................................................................. 41
   7.1 Call From Computer .................................................................................................................................................. 42
   7.2 Call From Phone ....................................................................................................................................................... 42
   7.3 Answer Call ............................................................................................................................................................... 43
   7.4 Contact Name Lookup for Incoming Calls ................................................................................................................ 43
   7.5 Missed Call or Communication .................................................................................................................................. 43
   7.6 Full Screen in Video Call ............................................................................................................................................. 43
   7.7 Multiparty Sessions .................................................................................................................................................... 44
   7.8 Call Waiting ............................................................................................................................................................... 44
7.9 Call Transfer .......................................................................................................................... 44
7.10 Message Waiting Indication and Visual Voice Mail ................................................................. 44
7.11 Call Park and Retrieve ............................................................................................................. 45
7.12 Call Pull .................................................................................................................................. 45
7.13 Call Recording Controls ......................................................................................................... 45
7.14 Moderator Controls .................................................................................................................. 46
7.15 Forced Logout .......................................................................................................................... 47
7.16 Echo (Test) Service .................................................................................................................. 47
7.17 Headset Support ....................................................................................................................... 47
7.18 Team Telephony ....................................................................................................................... 48
7.19 Executive-Assistant .................................................................................................................. 48
7.20 Presence Rules and Silent Alerting ........................................................................................... 49
7.21 Personal Assistant .................................................................................................................... 49
7.22 Call Center Agent Login ......................................................................................................... 50
7.23 Remote Control Event Package ............................................................................................... 51
7.24 Auto-Answer ............................................................................................................................ 51
7.25 Web Pop ................................................................................................................................... 51
7.26 Hide Communications Window Notifications and Tones ....................................................... 51
8 Application or Desktop Share ...................................................................................................... 52
9 My Room ..................................................................................................................................... 53
  9.1 Guest Client ............................................................................................................................... 54
10 Search ....................................................................................................................................... 55
11 Full Enterprise Directory ............................................................................................................ 58
12 Communications History ............................................................................................................. 59
13 Click-to-Call (Highlight Text) ..................................................................................................... 60
14 Callto and Tel URL Schemes ...................................................................................................... 61
15 XMPP Security ............................................................................................................................ 62
16 Web Button ............................................................................................................................... 63
17 Outlook Add-in ............................................................................................................................ 64
  17.1 Introduction ............................................................................................................................... 64
  17.2 Supported Platforms ................................................................................................................. 64
  17.3 Log Files .................................................................................................................................. 65
  17.4 Windows Registry Entries ....................................................................................................... 66
  17.5 Installation ............................................................................................................................... 67
  17.6 Features ................................................................................................................................... 67
    17.6.1 Presence in Outlook .............................................................................................................. 67
    17.6.2 Contact Actions in Outlook ............................................................................................... 68
    17.6.3 Call Multiple Phone Numbers Configured for Communicator / Non-Communicator
    Contacts ..................................................................................................................................... 69
  17.7 Uninstall Outlook Add-in for Communicator .......................................................................... 70
  17.8 End-User Configuration .......................................................................................................... 71
17.8.1 SIP Address in Microsoft Outlook Contacts ................................................................. 71
18 CC-One Integration ........................................................................................................... 73
19 UC-One Add-In for Microsoft Skype for Business ............................................................... 74
20 Emergency Calls ............................................................................................................. 75
  20.1 Emergency Call Address Change Service .............................................................. 75
21 UC-One Hub .................................................................................................................... 76
  21.1 Introduction ............................................................................................................... 76
  21.2 Hub Banner (Micro-app) View .................................................................................. 77
    21.2.1 Google Calendar .................................................................................................. 77
    21.2.2 Gmail ................................................................................................................... 77
    21.2.3 Google Drive ........................................................................................................ 78
    21.2.4 Google Tasks ....................................................................................................... 78
    21.2.5 Box ....................................................................................................................... 78
    21.2.6 Concur .................................................................................................................. 78
    21.2.7 Team-One ............................................................................................................ 78
    21.2.8 Twitter .................................................................................................................. 79
  21.3 Contextual Gadget ...................................................................................................... 79
    21.3.1 Gmail ................................................................................................................... 80
    21.3.2 Gmail and Google Drive Files .......................................................................... 80
    21.3.3 Twitter .................................................................................................................. 80
    21.3.4 Google Calendar .................................................................................................. 80
22 Forced Configuration Update ............................................................................................ 81
23 Password Change ............................................................................................................. 82
24 Privacy Policy ................................................................................................................... 83
25 Accessibility Compliance .................................................................................................. 84
26 Google Analytics ............................................................................................................. 85
27 Personal Identity Verification Support .............................................................................. 86
28 Federal Information Processing Standard Compliancy ..................................................... 87
29 IPv6 Support .................................................................................................................... 88
30 Preferences .................................................................................................................... 89
  30.1 General ....................................................................................................................... 89
  30.2 Audio/Video ............................................................................................................... 90
    30.2.1 Audio ................................................................................................................... 90
    30.2.2 Video .................................................................................................................... 90
  30.3 Incoming Calls .......................................................................................................... 91
  30.4 Outgoing Calls .......................................................................................................... 91
  30.5 Voice Mail .................................................................................................................... 91
  30.6 Services ....................................................................................................................... 91
  30.7 Extensions .................................................................................................................. 91
  30.8 Advanced ................................................................................................................... 91
31 Call Settings ........................................................................................................................................ 93
  31.1 BroadWorks Anywhere ................................................................................................................ 93
  31.2 BroadWorks Remote Office ........................................................................................................ 94
  31.3 Forward Calls ............................................................................................................................. 94
  31.4 Do Not Disturb ........................................................................................................................... 94
  31.5 Hide Number .............................................................................................................................. 94
  31.6 Simultaneous Ring Personal .................................................................................................... 94
  31.7 Voice Messaging ........................................................................................................................ 94
  31.8 Anonymous Call Rejection .................................................................................................... 95
  31.9 Automatic Callback ................................................................................................................ 95
  31.10 Call Waiting ............................................................................................................................ 95
32 Sign Out ......................................................................................................................................... 96
  32.1 Sign Out of Communicator ........................................................................................................ 96
  32.2 Exit Application .......................................................................................................................... 96
33 Multi-Device Support ................................................................................................................... 97
34 Installation .................................................................................................................................... 99
35 Uninstallation ................................................................................................................................ 100
  35.1 Windows ................................................................................................................................... 100
  35.2 OS X ......................................................................................................................................... 100
36 Version Control and Automatic Upgrade ................................................................................ 101
37 System Requirements .................................................................................................................. 102
38 Troubleshooting .......................................................................................................................... 103
Appendix A: Keyboard Shortcuts for Desktop ............................................................................. 108
Appendix B: Guest Client Usage .................................................................................................... 110
Appendix C: Skype for Business Integration .................................................................................. 114
Appendix D: Configure USB Headsets .......................................................................................... 118
Appendix E: Multi-Device Presence .............................................................................................. 126
Appendix F: Third-Party Software and Copyright ........................................................................ 127
Appendix G: Acronyms and Abbreviations ..................................................................................... 132
Table of Figures

| Figure 1 | Tabbed Main Window | 28 |
| Figure 2 | Presence Displayed in Outlook | 67 |
| Figure 3 | Presence Values | 67 |
| Figure 4 | Contact Options | 68 |
| Figure 5 | Contact Card | 69 |
| Figure 6 | Received Mail Context Menu in Outlook | 70 |
| Figure 7 | Contact Item Context Menu in Outlook | 70 |
| Figure 8 | Outlook Contact Properties | 71 |
| Figure 9 | SIP Address for Outlook Contact | 72 |
| Figure 10 | Download Address Book | 72 |
| Figure 11 | Desktop Main Window | 76 |
| Figure 12 | Outlook Account Information – Add-in Disabled | 105 |
| Figure 13 | Microsoft Office Installation Example | 106 |
| Figure 14 | Communicator Preference Page | 106 |
| Figure 15 | Communicator Preference Page | 106 |
| Figure 16 | Outlook Add-in IM Buttons Issue | 107 |
| Figure 17 | Copy Guest Join Link Menu Option | 110 |
| Figure 18 | Login Screen for Join Room | 110 |
| Figure 19 | My Room Icon – Guest Request Badge | 111 |
| Figure 20 | My Room – Accept Guest Request | 112 |
| Figure 21 | My Room Window – Guest Chat | 112 |
| Figure 22 | My Room Window Icons | 113 |
| Figure 23 | My Room – Desktop Share with Video Call | 113 |
| Figure 24 | Making an On-Net Call | 115 |
| Figure 25 | Ongoing On-Net Call | 115 |
| Figure 26 | Making an Off-Net Call | 116 |
| Figure 27 | Ongoing Off-Net Call | 116 |
| Figure 28 | Preferences Window | 119 |
| Figure 29 | Sound Window – Playback Tab | 120 |
| Figure 30 | Sound Window – Playback Tab – Set Default | 121 |
| Figure 31 | Sound Window – Playback Tab – Default Set | 122 |
| Figure 32 | Sound Window – Recording Tab | 123 |
| Figure 33 | Sound Window – Recording Tab – Set Default | 124 |
| Figure 34 | Sound Window – Recording Tab – Default Set | 125 |
1 Summary of Changes

This section describes the changes to this document for each release and document version.

1.1 Changes for Release 22

Changes for Release 22.7.0, Document Version 1
This version of the document includes the following changes:
- Added an additional note about Single Sign-On (SSO) and login checkbox.
- Updated Hub section for O365.
- Added a note about spell checking in US English.
- Added new features:
  - Brandable URL schemes
  - Silent alert setting configurability
  - Alert me first setting
  - Service name search results configurability

Changes for Release 22.6.1, Document Version 1
This version of the document includes the following changes:
- Added an additional note about automatic upgrade limitations.
- Added a note about OS locale for the Personal Assistant.
- Added a note about Call Waiting in ringing state.
- Added a note about My Room calls not supporting transfer or conference.
- Added a note about message storage on the server side in the history.

Changes for Release 22.6.0, Document Version 1
This version of the document includes the following changes:
- Added a note about toggling audio devices in calls.
- Added a note about clicking installer EULA two times.
- Added a note about managing (transfer and conference) My Room calls.
- Added note for Personal assistant contact hover.
- Added note for Outlook Add-in duplicate contacts.
- Updated system requirements to add Mojave.
- Added the following new features:
  - S4B window minimizing
  - Urgent/confidential flag in visual voice mail

Changes for Release 22.5.3, Document Version 1
This version of the document includes the following changes:
- Added a note about canceling My Room invitations sent by the user.
Added a note about automatic upgrade.

Added a note about USB headset add-ins.

Added a note about location rules.

Changes for Release 22.5.0, Document Version 1
This version of the document includes the following changes:

- Added the following new features:
  - Alert info
  - Forced Device Management (DM) file update
  - Personal Assistant
  - Security Assertion Markup Language (SAML) Single Sign-On (SSO) context
  - Call and chat history sync
  - No-sub support
  - Portuguese as an official language
  - Up to four web buttons
  - Windows Personal Identity Verification (PIV) and non-PIV support
  - Automatic presence

Changes for Release 22.4.0, Document Version 2
This version of the document includes the following changes:

- Added a note to the USB headset section about vendor-specific add-ins.
- Added a note about USB headsets to Skype for Business (S4B) section.

Changes for Release 22.4.0, Document Version 1
This version of the document includes the following changes:

- Added the following new features:
  - SSO enhancement
  - Login URL list (region)
  - Connect group messaging enhancements
  - Screen share zooming
  - Privacy policy link
  - Callto and Tel URL schemes
  - IPv6 support (preview)
  - Directory search result enhancement
  - Suppressing message notifications when sharing
- Added a further note about moderated My Room.
- Added examples about multi-part search enhancements.
- Updated system requirements to remove OS X 10.10.
- Added a note about DM URL clearing password.
Added a note about EmojiOne library usage to EULA.
Updated images.
Updated FAQ.
Updated Hub section.
Updated guest client appendix.

Changes for Release 22.3.2, Document Version 1
This version of the document includes the following changes:
- Added a note about S4B submenu and minimizing behavior.
- Added more information on moderated My Room.
- Made editorial updates.

Changes for Release 22.3.0, Document Version 1
This version of the document includes the following changes:
- Added a note about uninstall string translations in Windows start menu.
- Removed Outlook 2007 from supported list.
- Updated system requirements.
- Added a note about Emojis to Appendix A: Keyboard Shortcuts for Desktop and section 6.1 Chat View.
- Added new features:
  - Single installer
  - S4B and Outlook Add-in co-existence
  - IM retention
  - Automatic upgrade
  - Secure call icon
  - Moderated My Room

Changes for Release 22.2.1, Document Version 1
This version of the document includes the following change:
- Added a note about the external web collaboration browser window used in older environments.

Changes for Release 22.2.0, Document Version 1
This version of the document includes the following changes:
- Updated section 30 Preferences.
- Added a note about Outlook versions.
- Added a note about active speaker in My Room.
- Added the following new features:
  - Google analytics
  - Call transfer dialog search
  - Spell checking
− Full Emoji support
− Call Pull button in Xtended Services Interface (Xsi) calls
− Export My Room attendee list
− Revised attendee list
− Ability to toggle audio device between headset and PC speakers/microphone
− Web tab view

Changes for Release 22.1.0, Document Version 1
This version of the document includes the following changes:
■ Added a note about vendor-specific USB headset add-ins.
■ Added the following new feature:
   − S4B menu enhancement
■ Revised USB headset appendix.

Changes for Release 22.0.1, Document Version 1
This version of the document includes the following changes:
■ Added a note about LDAP credentials.
■ Added a note about installing with different app names.

Changes for Release 22.0.0, Document Version 1
This version of the document includes the following changes:
■ Modified notes about group chat when group messaging is used in section 3.8 Make Audio or Video Call and 6.3 Group Chat.
■ Added a note about Outlook Add-in installation when Outlook is upgraded/downgraded.
■ Added the following new features:
  − Federal Information Processing Standard (FIPS) compliance
  − PIV support
  − UC-One Hub for Communicator Desktop
  − Hiding Communications window notifications and tones
  − CC-One integration
■ Removed Chrome.

1.2 Changes for Release 21

Changes for Release 21.6.0, Document Version 2
This version of the document includes the following change:
■ Modified note about presence blocking.
Changes for Release 21.6.0, Document Version 1
This version of the document includes the following changes:

- Added the following new features:
  - Accessibility compliance:
    - Dictation
    - Screen reader
    - Keyboard navigation
  - Enhanced call logs
  - Web pop
  - Search enhancements
  - Display name matching enhancements
  - User interface (UI) update
- Added text for OS X uninstallation.
- Added Chrome updates.
- Added Outlook Add-in section.
- Added a note about Virtual Desktop Infrastructure (VDI) environments not being supported.

Changes for Release 21.5.2, Document Version 1
This version of the document includes the following changes:

- Modified system requirements to remove OS X 10.9.
- Added text about calling from phone.
- Updated active communication menu option text.
- Updated standard HID text.
- Added highlight text note.

Changes for Release 21.5.0, Document Version 1
This version of the document includes the following changes:

- Added default call type text.
- Added information about the following new features:
  - Xsi incoming call notification
  - Auto-answer
  - Search enhancements
  - Click-to-Call (highlight text)
  - Call Settings enhancements
  - Contact card enhancements
  - Group messaging
  - Integrated Outlook Add-in installer
Changes for Release 21.4.0, Document Version 1
This version of the document includes the following changes:

- Added information about new features:
  - S4B integration
  - N-way participant list for owner in non-Video Server (UVS) case
- Changed in Busy – In Meeting presence triggering.
- Added Appendix C: Skype for Business Integration.
- Added Appendix D: Configure USB Headsets.
- Updated section 38 Troubleshooting.

Changes for Release 21.3.3, Document Version 1
This version of the document includes the following changes:

- Added Remote control event package support.
- Added note about terminating Xsi Call Control.
- Added note about typing in group chat.
- Added share selector text.
- Added note on passwords.
- Added note on active communications.
- Added note on Video Server (UVS) ad hoc session.
- Added headset text.
- Added note on installation.

Changes for Release 21.3.0, Document Version 1
This version of the document includes the following changes:

- Added OS X 10.11 support to system requirements and removed 10.8.
- Changed the application name to Communicator and added the new application logo.
- Updated EULA text.
- Added UC-One Desktop for Chrome.
- Added S4B note on startup sequence.
- Modified keyboard shortcuts.
- Added the following new features:
  - Presence on demand
  - Message history and badge sync
  - Password change
  - Emoji support
  - Accessibility compliance – menus
  - Application sharing
  - Select screen to share
Suppress typing sound while in a call

Changes for Release 21.2.0, Document Version 2
This version of the document includes the following change:
- Added information about limits for active communication sessions.

Changes for Release 21.2.0, Document Version 1
This version of the document includes the following changes:
- Changed text for chat in presence table.
- Added section 35 Uninstallation.
- Changed share text to reflect the new implementation.
- Removed Vista and OS X 10.7 and added Windows 10.
- Added a note on Window management.
- Updated guest client system requirements.
- Updated headset list.
- Added the following new features:
  - Share passing
  - Presence rules and silent alerting
  - Password change
  - Visual voice mail (preview)
  - Call center login
  - SIP URI dialing
  - Skype for Business (S4B)

Changes for Release 21.1.0, Document Version 2
This version of the document includes the following changes:
- Changed text for My Room.
- Changed text for dial pad.
- Added a note about OS X ambient noise reduction.
- Changed text for audio devices.
- Changed text for multi-device chat.
- Changed test for contact profile edit.
- Removed Appendix B.
- Made editorial changes.
- Added Appendix G: Acronyms and Abbreviations.

Changes for Release 21.1.0, Document Version 1
This version of the document includes the following changes:
- Added the following new features:
  - Terminating Xsi Call Control
− Web button
− Extensible Messaging and Presence Protocol (XMPP) security enhancements
− ECACS menu
− UC-One Add-in for Microsoft Lync
− Local Group chat history

• Added Appendix B: Guest Client Usage for guest client.
• Added guest client browser requirements.
• Updated audio devices list.
• Made editorial changes.
• Modified text about Plantronics Spokes installation in section 38 Troubleshooting.
• Added the Table of Figures section.
• Updated section 3.11 My Room and 9 My Room with a note on link limitations.

Changes for Release 21.0.0, Document Version 2
This version of the document includes the following changes:
• Added copyright text.
• Added note about contact list size.
• Added note about Feature Access Codes during calls.
• Added note about escape in full screen video.

Changes for Release 21.0.0, Document Version 1
This version of the document includes the following changes:
• Modified the text for preferences.
• Added text about new features: Team Telephony, Executive-Assistant, Guest Client, search enhancements, ECACS, and display name for incoming calls.
• Made editorial changes.
• Updated images.

1.3 Changes for Release 20

Changes for Release 20.2.0, Document Version 2
This version of the document includes the following changes:
• Modified text for My Room Invitation.
• Made editorial changes.

Changes for Release 20.2.0, Document Version 1
This version of the document includes the following changes:
• Added text about new features: Meet-Me moderator controls and active communication extra buttons.
• Added text to call recording.
• Modified voice mail text.
Updated image.
Updated text for preferences.

Changes for Release 20.1.1, Document Version 1
This version of the document includes the following changes:
- Added text about Plantronics Spokes installation to section 38 Troubleshooting.
- Modified section 37 System Requirements.
- Modified search text in section 10 Search.

Changes for Release 20.1.0, Document Version 1
This version of the document includes the following changes:
- Added info about new features: echo service, forced logout, integrated call window, configurable left pane order, silent dialing into Meet-Me conference, flexible contact card configuration, and add-in enhancements.
- Added an appendix on USB devices.
- Added Outlook 2013 support.

Changes for Release 20.0.2, Document Version 2
This version of the document includes the following changes:
- Modified table in section 3 Get Started.
- Added more devices to the supported headsets list.
- Added a note to My Room section and to section 3.9 Share Your Application or Desktop.
- Added a note to share section about the web link availability.

Changes for Release 20.0.2, Document Version 1
This version of the document includes the following changes:
- Modified icons in section 3 Get Started.
- Edited keyboard shortcut table in Appendix A: Keyboard Shortcuts for Desktop.
- Added text about headsets.
- Added BroadWorks Anywhere to supported toolbar services.
- Added note to automatic Busy–In Call presence for Xsi calls.
- Modified text for silencing incoming calls.

Changes for Release 20.0.1, Document Version 2
This version of the document includes the following change:
- Modified text in section 7.11 Call Park and Retrieve.

Changes for Release 20.0.1, Document Version 1
This version of the document includes the following changes:
- Modified text in section 12 Communications History.
- Modified text in section 3.10 Active Communications.
Changes for Release 20.0.0, Document Version 2
This version of the document includes the following change:
- Modified text in section 7.3 Answer Call.

Changes for Release 20.0.0, Document Version 1
This version of the document includes the following changes:
- Added new features: Security Classification, Attended Transfer, Call Pull, Call Park/Retrieve, Chat Room Moderation, Call and Chat Recording, logging enhancements, video enhancements, and emergency call enhancements.
- Updated images.

1.4 Changes for Release 10

Changes for Release 10.1.2, Document Version 1
This version of the document includes the following changes:
- Made minor modifications.
- Changed document-numbering scheme.

Changes for Release 10.1, Document Version 3
This version of the document includes the following changes:
- Added text for the login dialog.
- Added a list of keyboard shortcuts to Appendix A: Keyboard Shortcuts for Desktop.

Changes for Release 10.1, Document Version 2
This version of the document includes the following changes:
- Removed redundant text.
- Updated figures to reflect new icons.

Changes for Release 10.1, Document Version 1
This version of the document includes the following changes:
- Modified text regarding desktop sharing on dual screens and Xtended Services Interface mid-call controls, Call Settings toolbar, new icons, and so on.
- Updated figures to reflect new "skin".

Changes for Release 10.0.4, Document Version 1
This version of the document includes the following change:
- Modified section 37 System Requirements.

Changes for Release 10.0.3, Document Version 2
This version of the document includes the following change:
- Modified section 37 System Requirements.

Changes for Release 10.0.3, Document Version 1
This version of the document includes the following changes:
- Added section 3 Get Started.
- Added textual user guide of features.
- Updated hardware requirements to remove Mac OS 10.5.

Changes for Release 10.0.2, Document Version 1
This version of the document includes the following change:
- Added more FAQ entries on new features.

Changes for Release 10.0.1, Document Version 1
This version of the document includes the following change:
- Added more FAQ entries.

Changes for Release 10.0.0, Document Version 1
This is the first version of the document, introduced for Release 10.0.0.
2 About Communicator for Desktop

Communicator for Desktop is a native Windows or Mac OS client for Unified Communications, providing the following communication features:

- Instant Messaging and Presence
- Voice Calling (VoIP)
- Voice Calling (Desk phone)
- Video Calling
- Desktop Sharing
- BroadWorks Call Settings
3 Get Started

This section contains the essential information for getting started with Communicator. End users need to ensure they are using valid drivers for video (for example).

3.1 Installation

Your service provider provides the download of the installer.

Windows

- Double-click the installer executable and follow the installation instructions.
- Launch Communicator.

Mac OS

- Double-click the disk image.
- Copy the application into the Applications folder.
- Launch Communicator.

3.2 Sign In

When you first launch the application, you are prompted to sign in, and depending on your service provider settings, the login view is different.

Without SSO, the login flow is as follows:

If displayed, enter the login Uniform Resource Locator (URL) provided by the service provider.

1) Enter your BroadWorks user name and password (in PIV mode, only a PIN is needed).
2) Select whether you would like Communicator to remember your password.
3) Select whether you would like Communicator to sign you in automatically on subsequent launches.
4) Click Sign In.

When SSO is enabled, the login flow is typically as follows:

If displayed, enter the login Uniform Resource Locator (URL) provided by the service provider.

1) Click the correct Identity Provider (IdP) menu from the drop-down. In Release 22.4.0, the default supported IdPs are Okta, Google G Suite, Enterprise hosted Active Directory Federated Services, and Office 365. However, your service provider may also have their own IdPs.
2) As a result, an external web browser opens. Provide the SSO credentials in the web browser view and return to the Communicator login view. When logging in for the second time using SSO, your previously used IdP is remembered automatically. With SSO, Remember Password and Sign In Automatically checkboxes are not visible. When using the Exit option, the password does not have to be re-entered in SSO environments whereas with Logout, the password must be re-entered.
3) Select whether you would like Communicator to sign you in automatically on subsequent launches.
4) Click Sign In.
When login regions are enabled by your service provider, the login flow is typically as follows:

1) Select your region from the drop-down menu.
2) Enter your BroadWorks user name and password (in PIV mode, only a PIN is needed).
3) Select whether you would like Communicator to remember your password.
4) Select whether you would like Communicator to sign you in automatically on subsequent launches.
5) Click **Sign In**.

In Release 22.5.0 and later, depending on your service provider configuration, you may also have to enter your email address or access code with user name and password and after that select the IdP.

You can also access **Help**, **Preferences**, and login URL change view directly from the Login window.

**NOTE:** If you choose automatic sign in, you are automatically signed in and taken to the Main window upon subsequent Communicator launches. Otherwise, you are presented with the Sign In screen when launching the application. In the Main window, your default tab when signing in depends on service provider configuration; otherwise, Communicator remembers the tab you were on at sign out and opens that same tab at sign in.

The Login window offers the last used username, but the password shall be automatically filled in only if you have checked the **Save password** check box. If multiple people use the same machine, only the last password is entered as a security measure. If you change the username in the Login window through editing it, or using the drop-down list to pick another one, Communicator will not fill in the password; you are always expected to type it in. This also applies when re-selecting or re-entering the last used username.

If the DM URL is changed, the password is not remembered as a security feature.

After logging in, a pop-up dialog may appear informing you about emergency calls, and another about changing your location for emergency calls. You may also see a banner in the Main window related to emergency calls. Depending on your service provider settings, emergency calls may not be allowed. In this case, calling an emergency number displays a pop-up dialog. A notification message in the Main window may also display. It is not a supported configuration to run many Desktop clients at the same time with the same account.

**NOTE:** It is possible to run several Communicator instances at the same time, but headphone connectors and Outlook integration may not work as expected.

### 3.3 Main Window

When you start Communicator for the first time, your **Contacts** list is empty. Use the **Search and Dial** field to find people and add them to your **Contacts** list. Contacts can also be added manually by clicking the **Add** button. Client windows can also be set to always use the Main window menu option. Note also, that depending on your service provider settings, the order of the left pane icons can vary. The left pane Call Settings icon and menus are visible depending on your service provider settings. The dial pad is also integrated with the Main window.
Communicator uses tabs for new chat sessions. The Search and Dial field allows searching for contacts as well as making calls using phone numbers or SIP URIs (native Desktop only). SIP URIs must use the format user@domain or sip:user@domain. The table that follows the images describes the key icons used in the Main and Communications windows.

![Tabbed Main Window](image)

**Figure 1 Tabbed Main Window**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="My Information" /></td>
<td><strong>My Information</strong> – View and update your information, for example, your presence, avatar, and location.</td>
</tr>
<tr>
<td><img src="image" alt="Contacts" /></td>
<td><strong>Contacts</strong> – View your contacts.</td>
</tr>
<tr>
<td><img src="image" alt="My Room" /></td>
<td><strong>My Room</strong> – This is your permanent communication room. Participants can dial in to your audio bridge.</td>
</tr>
<tr>
<td><img src="image" alt="Call History" /></td>
<td><strong>Call History</strong> – View previous calls.</td>
</tr>
<tr>
<td><img src="image" alt="Chat History" /></td>
<td><strong>Chat History</strong> – View previous chats.</td>
</tr>
<tr>
<td><img src="image" alt="Full Enterprise Directory" /></td>
<td><strong>Full Enterprise Directory</strong> – Show all contacts of the directory.</td>
</tr>
<tr>
<td><img src="image" alt="Dial Pad" /></td>
<td><strong>Dial Pad</strong> – Make calls (it is integrated with the Main window).</td>
</tr>
<tr>
<td><img src="image" alt="Web Button" /></td>
<td><strong>Web Button</strong> – Provides web content inside the Main window or browser.</td>
</tr>
<tr>
<td><img src="image" alt="UC-One Hub" /></td>
<td><strong>UC-One Hub</strong> – Provides micro-apps and contextual intelligence to chat tabs.</td>
</tr>
</tbody>
</table>
### Icon | Usage
--- | ---
| ![Icon](image) | Preferences – Use for quick access to preferences and Call Settings such as Call Forwarding. |
| ![Icon](image) | Chat – Start an instant message conversation with a selected contact. |
| ![Icon](image) | Call – Make an IP audio call to a selected contact. |
| ![Icon](image) | Call from Phone – Make a Click To Dial call from your desk phone (or secondary device). |
| ![Icon](image) | Video Call – Make a video call to a selected client (VoIP). |
| ![Icon](image) | Share – Share either the whole screen or an individual application. |
| ![Icon](image) | Menu – Open Communications options. |
| ![Icon](image) | Add – Add a contact, group, or conference. |

### My Information
- Click the avatar to update your status or location and enter free text (native Desktop only).
- Double-click the avatar to upload a picture or use a right-click menu.
- Right-click the avatar to update your status (native Desktop only).

### Presence
You can set your presence to one status indicated in the following table.

<table>
<thead>
<tr>
<th>Icon</th>
<th>What it means</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Automatic presence: This is the Available status where automated presence statuses such as Busy In-call override the Available status. Requires newer presence server (aggregated presence) to show.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>The green presence icon indicates that the user is online and ready for communication. This status is used until you change it and automated presence statuses such as In Call do not override.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>The yellow presence icon indicates that the user is online but has been idle or away from their computer for more than ten minutes.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>The red presence icon indicates that the user is busy and does not want to be disturbed.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>The grey presence icon indicates that the user is offline and the only available contact method is calling or leaving a chat message.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>This icon indicates that the contact is busy on a call. This is an automated presence status.</td>
</tr>
</tbody>
</table>
## Icon

<table>
<thead>
<tr>
<th>Icon</th>
<th>What it means</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>This icon indicates that the contact is busy in a meeting. This is an automated presence status. The <em>Busy – In Call</em> status overrides the <em>Busy – In Meeting</em> status so this one is only seen if there is a meeting but no call.</td>
</tr>
</tbody>
</table>

Communicator can automatically update your presence to the following:

- *Busy – In Call*
- *Busy – In Meeting* (Windows only)
- *Available (desk phone)*
- *Available (mobile)*
- *Away on mobile*
- *Offline and busy in call*

### Location

Your location is automatically determined by your public IP address; however, you can manually set the text to appear for your location and time zone using the location dialog box.

## 3.4 Communications View

After starting communication with one or more contacts, a new tab is displayed for chat. The call window is also integrated with the *Main* window chat tab by default. You can separate a tab on to a different *Communications* window by dragging and dropping it outside of the *Main* window. From this view, you can perform the following actions:

- Escalate a chat to include audio, video, and desktop sharing
- End an audio or video call
- Open the dial pad
- Mute your microphone
- Adjust your speaker volume
- Place a call on hold
- Transfer a call
- Toggle between speaker and headset. You must specify different devices for a speaker and a headset in *Preferences* to use this feature.

If you are using several monitors, Communicator opens the *Communications* window as well as notifications on the same monitor as the *Main* window.

Starting with Release 21.2.0, Communicator limits the number of active communications to spare resources. The limit is 20 active communications on Windows and on Mac OS. If the maximum is reached, the main window’s top section warns user with the following message: *The maximum amount of communication windows has been reached. Please close some to open new ones.*

If an incoming call is answered while this warning is shown, the client closes the chat session that has the longest time since its last activity.
3.5 Start Chat

Start a chat tab using one of the following methods:

- Double-click a contact from the Contacts list or search results.
- Right-click one or more contacts from the Contacts list or search results and click the Chat menu item.
- On the Chat History list, double-click a chat entry.
- In a Communications window, click the Chat button (this does not open a new tab).
- In the Main window, click the Add button and in the resulting tab click the Chat icon.

3.6 Send File

- In a one-to-one chat, transfer files by clicking the Send File button in the Communications window or use the “drag and drop” method so that they are moved to the Communications window.

3.7 Send Email

Right-click a contact from the Contacts list or search results and select the Email menu option. The contact must have an email address defined for this feature.

3.8 Make Audio or Video Call

Make an audio or video call using one of the following methods:

- Right-click one or more contacts from the Contacts list or search results and select the Call, Call from Phone, or Video menu item. The menu items depend on service provider settings.
- Right-click one or more contacts from the Contacts list or search results and click the Call, Call from Phone, or Video. The menu items depend on service provider settings.
- Enter a phone number in the Search and Dial field.
  - Press ENTER to start a VoIP call.
  - Click the Call, Call from Phone, or Video button.
- Open the dial pad, enter a phone number, and then click the Call, Call from Phone, or Video button.
- On the Call History list, double-click a call entry.
- In the Communications window, click the Call, Call from Phone, or Video button.
- When viewing a contact’s profile, click the Call, Call from Phone, or Video button.

**NOTE:** If dialing a phone number that requires additional dual-tone multi-frequency (DTMF) tones (for example, a conference bridge), you can type the numbers on your keyboard while the Communications window has focus or open the dial pad in the Communications window.
3.9 Share Your Application or Desktop

Share your desktop by following these steps:

1) Click the **Start Sharing** button in the top of the *Communications* window (if share panel is not visible). The Share button is visible by default in My Room also. This button is available when your service provider has enabled share on your account. The share selector window opens.

2) Select the application to share or the entire screen of a particular display and click the **Start Sharing** button.

In addition, participants can also share when enabled by their service provider.

**NOTE**: To share your desktop, you must enter your web collaboration credentials in Preferences → Credentials, unless your service provider has automated provisioning in use. For more information, see section 30 Preferences. You can participate in desktop sharing sessions by another user even without having your own sharing credentials.

3.10 Active Communications

Active communications appear at the top of the *Contacts* list in the *Main* window (native Desktop only). This area provides an easy view to see the people with whom you are communicating. By default starting in Release 20.1.0, there is no separate call tab but call is shown in the *Active Communications* area in the *Main* window (where the call can be fully controlled in the Desktop client). It reduces the number of Communications windows; however, a separate call window can still be opened using an *Active Communications* menu. The following is also available in this area:

- Double-click an active communication item to bring this *Communications* tab to focus if the call window is separately shown. If the call window is integrated, you can use a menu option to show it separately.

- See who has sent you a chat message, but only after you accept the chat session. Before the chat session is established, the chat items are not visible in active communications but a history badge is visible.

- End a call.

- Mute the microphone.

- Place a call on hold.

- Merge two calls or transfer by dragging and dropping calls onto each other.

- Transfer a call.

- Make conference calls.

- See call recordings.

- Park and retrieve calls.

- Set audio device to headset or speaker. For more information, see section 30 Preferences.

As a service provider option, more buttons can be added to the active Communications area:

- Conference

- Call Transfer
- Call Park
- Call Pull

When enabled, you can use these buttons for faster access to services.

You can right-click the “More” icon of an active Communications item (icon with three dots) for additional options while a left-click offers additional call management options for this call as well as other options when available.

3.11 My Room

*My Room* is an always available and permanent room you can use to chat with anyone that joins.

If you assign a conference bridge to your profile in *Preferences → Credentials*, then in your room, you and your attendees can click the *Call* or *Video* button to have Communicator automatically dial in to the conference and enter the appropriate entry codes. Note, if your service provider has auto-provisioning enabled, then you cannot edit these details. If your service provider has silent dialing enabled, then you cannot hear any DTMF tones when dialing into My Room (the call is made automatically).

If a conference bridge is not specified, you cannot initiate a call in your room.

You can invite others to your room by dragging and dropping them from the Contacts list into the *My Room* tab. You can also use the right-click menu on the *My Room* icon in the top-right corner of the *Main* window or the *My Room* information area to copy an invitation link for guest users (people without Communicator). They can then click the link and join the meeting through a web browser. Guest users must be separately accepted for each session.

Contacts join your room by right-clicking your name on their contact list and selecting *Join Room* or by an invitation you sent.

Email *My Room* Invitation menu results in working links for guest users and Communicator users if enabled by your service provider. Communicator users are recommended to use “Copy Guest Link” invitation links; however, the btbc link part links when enabled by your service provider may not work in all applications as they were originally intended for Outlook.

You can also export the attendee list using the related participant menu available via the options icon (three dots).

In *My Room* calls, the owner can also see active speaker info with the Mute/Unmute icon.

*My Room* can also be moderated, for more information on moderation, see section 7.14 *Moderator Controls*.

*My Room* calls cannot be conferenced or transferred.

3.11.1 Select Audio Devices

If you have multiple audio devices available for your microphone or speakers, select the preferred audio device before starting a call.

**Windows**

1) Click the Communicator logo in the *Main* window title bar.

2) Select *Preferences*.

3) Select *Audio*.

4) Set a playback device (speakers).
5) Set a recording device (microphone).
6) Click **OK**.

**Mac OS**
1) Select *Communicator* from the main menu.
2) Select *Preferences*.
3) Select *Audio*.
4) Set a playback device (speakers).
5) Set a recording device (microphone).
6) Click **OK**.

If “Use default” is selected, then Communicator uses the default device set in the operating system preferences. For Windows, if “Default Communication Device” is defined, it is selected over the “Default Device”. If you are using headsets, you can also select a separate device than the headset for alerting incoming calls.

Note that on Mac OS it is recommended to disable “Use ambient noise reduction” in *System Preferences* to reduce echo.
4 Contacts

Contacts are the people with whom you communicate and, in most cases; you see their presence and share your presence with them. There are three types of contacts:

- **Contacts** – Actual people with whom you communicate.
- **Conferences** – Audio or video conference bridges that you use to communicate with others. Silent dialing into the bridge also applies to these contacts if enabled by your service provider. Conference contacts are regular contacts and are added just like regular contacts.
- **Groups** – Containers of contacts and/or conferences.

There is no hard coded limit on the number of contacts. The more contacts are added the more memory and processing is needed. The more contacts are added, the more difficult it is to find people without searching. Live search can be used instead of a very large local contact list while keeping memory and processing requirements to a minimum.

4.1 Add

When you sign in for the first time, there are no contacts on your contact list. Add a new contact at any time by selecting the **Add Contact** item from the menu or choose the **Add** button from the Main window (+ icon). In the resulting tab, you can select to add a contact, group, or other items.

In the **Add Contact** tab, enter the contact's information and then click **Save**. By default, your presence information is always shared with a new contact if an Extensible Messaging and Presence Protocol (XMPP) address is provided.

If you are accepting contacts via a buddy request, you may see the contact card after accepting the buddy request, depending on the service provider settings. When receiving a buddy request, there are two buttons for accepting and rejecting the request. Dismissing the buddy request window only ignores the request for the duration of the login session. It reappears after the next login.

However, you can always share your presence information later by selecting Subscribe on the right-click menu for a specific contact in the contact / directory list. Note that the contact must accept your subscription request for you to establish the presence relationship successfully.

The newly added contact appears on your contact list.

Add a conference contact by clicking the same button you did for **Add Contact**. A conference contact is a special contact used for conference bridges to avoid remembering PIN codes and conference number, for example, recurring conferences. Just create a contact for the weekly conference, add a conference bridge number and PIN, and join the conference just by right-clicking the contact or choosing it and clicking the **Call** button.

Choose the **Add Group** menu option to add a new group to the contact list.

Contact card telephone number fields can also have SIP URIs (work, mobile, extension, personal, and conference bridge). Release 21.5.0 introduced support for additional contact card fields.
4.2 Edit

Edit a contact by selecting the contact first. After you select the contact, right-click anywhere in the area of the selected contact and a menu of options appears which allows you to either view or edit the contact profile. In View mode, click the Edit button to go to Edit mode. This base principle is the same for normal contacts, conference contacts, and groups. Note that depending on your service provider settings all or no contact card fields may be editable. Depending on your service provider settings, you may also see a button for synchronizing the contact card with the Telephony Directory or the synchronization may take place automatically (native Desktop only). When the manual synchronization button (cloud icon) is visible, there is no automated syncing of the contact card details with server information. To synchronize the contact card data, click on the cloud icon.

- **Unsubscribe** removes the presence relationship between you and that contact. This means you do not see the contact’s presence information and your contact does not see yours. To re-establish the presence relationship, select **Subscribe**. An unsubscribed contact remains on the contact list and is always shown without an icon. Any contact that is not presence-enabled is shown in the same way.
- **Delete contact** removes the contact from your contact list.
- **View Profile** opens the Contact Information dialog box where you can add, edit, or remove information. This works for both normal and conference contacts.
- For groups, choose the **Edit** menu option to rename a group.

Once done with all changes, click the **Save** button.

4.3 Filters

You can filter contacts in two ways:

- Use the **filter** field to search by contact name. The contact list is filtered in real time as you type.
- Alternatively, use the filter menus available by right-clicking the **Contacts** icon in the left pane to display only specific types of contacts such online contacts (native Desktop only). You can also sort contacts based on first or last name or choose whether to display the contact’s avatar and availability status in the contact list.

Favorite filtering works slightly differently in Release 21.2.0 and later:

- When you make a contact your favorite, the favorite group shows on top of the contact list and cannot be hidden.
- When you delete all your favorite contacts, the favorite group does not show anywhere.
- When you have even one favorite marked, you see the group.
5 Presence

For each contact you have subscribed to, you can see their presence. Similarly, your contacts can see your presence on their contact list.

Presence means that your friends are able to see whether you are available to communicate, for example, “I’m busy” or “I’m available”.

<table>
<thead>
<tr>
<th>Icon</th>
<th>What it means</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Automatic presence" /></td>
<td>Automatic presence: This is the Available status where automated presence statuses such as In-call override the Available status. Requires newer presence server to show.</td>
</tr>
<tr>
<td><img src="image" alt="Green presence" /></td>
<td>The green presence icon indicates that the user is online and ready for communication. This status is used until you change it and automated presence statuses such as In Call do not override.</td>
</tr>
<tr>
<td><img src="image" alt="Yellow presence" /></td>
<td>The yellow presence icon indicates that the user is online but has been idle or away from their computer for more than ten minutes.</td>
</tr>
<tr>
<td><img src="image" alt="Red presence" /></td>
<td>The red presence icon indicates that the user is busy and does not want to be disturbed.</td>
</tr>
<tr>
<td><img src="image" alt="Grey presence" /></td>
<td>The grey presence icon indicates that the user is offline and the only available contact method is calling or chatting.</td>
</tr>
<tr>
<td><img src="image" alt="Question mark" /></td>
<td>The question mark indicates that a subscription is pending and the contact has not yet approved sharing their presence.</td>
</tr>
<tr>
<td><img src="image" alt="Busy – In Call" /></td>
<td>This icon indicates that the contact is busy due to a call. This is an automated presence status.</td>
</tr>
<tr>
<td><img src="image" alt="Busy – In Meeting" /></td>
<td>This icon indicates that the contact is busy due to a meeting. This is an automated presence status. The Busy – In Call status overrides the Busy – In Meeting status so this one is only seen if there is a meeting but no call.</td>
</tr>
<tr>
<td><img src="image" alt="Mobile" /></td>
<td>This icon indicates that the contact is only available on mobile Communicator.</td>
</tr>
<tr>
<td><img src="image" alt="Desktop" /></td>
<td>This icon indicates that the contact is only available on a compatible desktop phone, and not Communicator.</td>
</tr>
<tr>
<td><img src="image" alt="Mobile only" /></td>
<td>This icon indicates that only the mobile client is online and in the away status. This was a Preview feature in Release 21.5.0.</td>
</tr>
<tr>
<td><img src="image" alt="Desktop only" /></td>
<td>This icon indicates that the user is in a call but is not logged in to XMPP (presence and chat). This was a Preview feature in Release 21.5.0.</td>
</tr>
</tbody>
</table>

The avatar in this version is not completely in real time. The avatars are retrieved at login, when the contact is added, and when the contact comes online. Double-click the avatar to change your avatar. A File Explorer view opens.

If you see an error message at the top of the Main window “XMPP Unavailable”, it means that the XMPP connectivity has been lost for chat and presence; however, you can still make calls. You should contact your service provider.

Have the Outlook calendar automatically change your presence to Busy – In Meeting by enabling this in the Preferences → General tab (native Desktop only).

The presence update is only triggered by appointments and meetings that are in the Show me as busy state.

The XMPP address of a contact cannot be changed. Instead, you must delete the old contact and create a new one.
Location in presence is done based on the IP address that the machine is using on Windows. The IP address is mapped to a physical location. BroadSoft is working with the mapping provider to improve the accuracy of the location. On Mac OS, the operating system location is utilized. You will be prompted to accept location usage. Change the location manually by clicking the avatar (if presence controls are not already expanded) and then the location icon to go to the manual location and change the view.

Snapshot of presence status is also available in search results and Communications window for contacts who are not buddies. This presence status is not updated after the search is done or after the communication session is set up.

5.1 Automated Presence

As a service provider option starting in Release 22.5.0, automated presence may be used. When used, contact addition no longer uses a buddy request dialog instead all presence subscriptions are automatically accepted by the network. This results in asymmetric presence relationships where you see the presence of the contacts you have added but they do not see your presence until they add you as a contact. This feature requires a newer server version (aggregated presence) to show.
6 Chat

6.1 Chat View

When you initiate a chat, the Chat tab inside the Main window opens. Chatting with a contact is possible only when you are both online. If your contact initiates a chat, you see a pop-up notification in the bottom right-hand corner of the screen. If you close the Chat tab and open it again, sent chat messages are shown in the tab as chat history. When enabled by your service provider, a typing notification is also shown.

When the chat opens, you see the contact’s information at the top of the screen.

At the top of the message area, there are four links: Yesterday, Last week, Last month, and All history. From these links, you can load history from your local storage and different timeframes. Depending on your history, some links may not be visible if there is no data to show. You can delete the history using the drop-down menu.

In the text field, you can add a smiley emoticon. Smiley emoticons can also be added by manually entering the corresponding characters that represent that particular emoticon. You can send text by pressing ENTER.

The full set of Emojis is also supported and they are rendered as ordinary emoticons when received. Spell checking in US English is also supported and can be disabled in Preferences. The implementation of Emojis is different between Releases 22.1 and 22.4 and later so sending Emojis between those may not fully work. For troubleshooting tips, see section 38 Troubleshooting.

To enter a line break in the text field, you can use the following key commands:

- CTRL+ENTER (command+enter on Mac)
- SHIFT+ENTER
- ALT+ENTER

Use either one of the short commands, CTRL+C or CTRL+V, or right-click the selection for a menu to copy or paste the text to or from the Chat tab.

It is also possible to chat with users in other domains. BroadCloud also supports Google federation. Group chat is not supported in Google federation, so the group chat option with these contacts is shown in grey.

All sent and received chats are stored locally in the chat history and an optional message history feature provides multi-device enhancements so that messages sent or received in other own devices would also be shown.

Depending on your service provider settings, older chat messages may be automatically deleted. In this case, the history links in the top area of the Chat view are automatically adjusted.

6.2 File Transfer

File transfer functionality is only accessible through the Chat tab.

1) To open the File Selection dialog box, click the Send File button located to the side of the text field.

2) From the dialog, select the file to be sent, and then click Open. You can also drag and drop a file into the Chat tab.

3) Once the file offer is issued and during its transfer, you can cancel the transfer (at any time) by clicking Cancel.
4) Accept an incoming file transfer by clicking the **Accept** button.

5) Reject the file transfer offer by clicking the **Decline** button.

After the file transfer has completed, the received files can be opened or viewed in the file manager by using the *File received, click to open*, and *Show in folder* links.

In error situations, partially received files are not deleted automatically.

### 6.3 Group Chat

Start a group chat by “multi-selecting” and right-clicking the **Main** window contact list. More people can be added later to the chat by “drag and drop”. Only the owner can add more participants. Depending on your service provider settings, the right-click menu items may differ. Newer group chat deployments only have the My Room right-click menu item available for calls.

A group chat works the same way as a one-to-one chat in a tabbed view. All messages from anyone are sent to everyone else. All contacts need to be online to be able to participate in a group chat. You cannot invite an offline contact or a contact that is not on a device that supports group chat. This does not affect the group chat in any way.

A group chat history is saved both in My Room and in ad hoc chat rooms and is available to view later in the **Messages** tab of the **Main** window.

In the text field, the contacts’ names appear in different colors to easily distinguish between who is writing.

Only the newest chat room messages are stored on the server. One-to-one chat messages are only saved locally. When the optional *Message History* feature is enabled by your service provider, messages sent from your other devices are also shown.

Deleting a chat room is not supported.

Chat rooms can be moderated by the owner. Use the right-click menu options to remove a participant from your chat room. If needed, the removed participant can join later. The removal also applies to desktop share sessions.

Typing notifications are not supported in group chats.

Release 21.5.0 introduced support for receiving group messages sent from UC-One Connect while Release 22.4.0 added support for also initiating Connect group messaging sessions. New Connect group message threads are created using the **New** button (+ icon in the **Main** window) and in the opened view selecting chat discussion participants and then sending at least one message to the selected participants.

### 6.4 Chat Recording

Chats can also be recorded as a service provider option (native Desktop only). In this case, the client shows a recording indicator. Note that there are no end-user controls for chat recording.
7 Audio and Video Calls

The following table describes additional *Communications* window icons and explains what you can do with them, for voice and video calls.

<table>
<thead>
<tr>
<th>Icon</th>
<th>What you can do</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Camera icon]</td>
<td>Add or remove video from the call.</td>
</tr>
<tr>
<td>![Microphone icon]</td>
<td>Mute your microphone by clicking the mute icon.</td>
</tr>
<tr>
<td>![Hold icon]</td>
<td>Put the call on hold. Note that if you hold the call, the other party cannot “unhold”. This freezes a video call to the last frame of the video feed. In both voice and video calls, this is communicated to all parties by a notification appearing in the middle of the screen.</td>
</tr>
<tr>
<td>![Menu icon]</td>
<td>Use this icon to access the <em>Call Options</em> menu. In the <em>Call Options</em> menu, you can find different actions to use for a call depending on your settings and your service provider.</td>
</tr>
</tbody>
</table>

In the *Options* menu, there are the following options:

- Transfer a call to a third party.
- Put the call on hold. Note that if you hold the call, the other party cannot “unhold”. This freezes a video call to the last frame of the video feed. In both voice and video calls, this is communicated to all parties by a notification appearing in the middle of the screen.
- Adjust the volume bar to adjust the volume. Dragging it all the way to the left mutes your speakers.
- Enter additional digits using the dial pad at any time during the call (for example, to insert a conference number). The dial pad is not movable.
- Toggle between the audio headset and speakers. You must specify a different device for a headset and a speaker in *Preferences* to be able to use this feature.
- Add participants to the call.

As an alternative, in general, available Feature Access Codes (FACs) for call management work during calls, for instance *55 for direct transfer to voice mail, but the ongoing call must be put on hold and a new call must be made to the FAC number. Using DTMF for the same purpose does not work.

When establishing a call to a contact, you can choose several ways to call. Right-click the contact you want to call and select the *Call* menu item. You can choose the number to call from a right-click menu. There can be several phone numbers available in the menu. The work phone is the default and top-most number is followed by mobile and other numbers. This also applies to the transfer and conference windows. However, in certain cases, the transfer/conference default number can differ from other call options in other menus.

The default call type can also be selected using accessibility menus (*Calls → Dialing service*). This controls the default call type when using call buttons.
Dial a number or SIP URI of format user@domain or sip:user@domain in the combined Search and Dial field to make a call (native Desktop only). Once you type your numbers, Communicator searches for contacts on both the local contact list and the enterprise directory.

You can also call circuit-switched network numbers such as Global System for Mobile Communications (GSM); however, this depends on the service provider network you are using; there is no technical limitation.

Choose your video size from the Preferences and the Video tab. Your selection is used by default for future video calls. The available sizes are automatically presented based on your camera.

You cannot have two simultaneous calls with the same person.

Communicator does not add video to an audio call without end-user consent. This also applies to blind video call transfer cases where audio-only music on hold is used; this may result in the transferred call being reduced to audio.

You can also see a secure call icon when an encrypted call is taking place.

**NOTE:** There is sleep prevention during calls.

### 7.1 Call From Computer

Select a contact from your contact list to start communication and click the desired communication button. To communicate with someone who is not on your contact list, type a phone number in the Search and Dial field at the top of Communicator window (search or communicate).

### 7.2 Call From Phone

The second option to communicate in the row of communication buttons is the Call from Phone. When you click this button, the desk phone instantly starts ringing and the call is established from your desk phone. This depends on your service provider configuration as other devices may also ring.

When your service provider is configured to also initiate a call from computer (SIP call) to the same machine that initiated a call from phone, that incoming (SIP) call will be accepted and will alert if it does not have the same identity as the call from phone.

For remote calls initiated using Communicator, you can also have mid-call controls such as hold/resume, transfer, and add participant.

Automatic Busy – In Call presence also works with the Call from Phone feature.

Depending on your service provider settings, it is also possible to control calls initiated without Communicator in the Active Communications view. The same mid-call controls are also available in this case. In case of an incoming call, the actual answering action must happen with the other device.
7.3 Answer Call

When someone is calling you, you see a pop-up notification on your screen. You can choose to answer, silence the incoming call, and then open a chat session with the caller, reject the call, or silence the incoming call by closing the pop-up notification window. If you silence the call, the ringtone is silenced but the caller does not see anything on their end. You can answer or reject the call after silencing it only if you have chosen the chat option. If you close the incoming call pop-up notification to silence an incoming call, then you do not have an option to answer or reject it any more. When choosing the chat option, chat is only enabled after the call has been answered or rejected.

If you reject the call, it causes the line to sound busy at the caller's end and they know that you rejected the call.

When someone is calling you with a video, you see the same pop-up notification; however, the options are answer with video, answer as voice only, silence and chat, reject, or silence (by closing the pop-up window). If you decide to answer as voice only, the call is voice only.

7.4 Contact Name Lookup for Incoming Calls

Communicator performs a local contact search for incoming calls. If the number matches one of the contacts on the Communicator contact list, the name is shown on the incoming call screen along with the alert. Both the display name and phone number are shown when available.

If there is no match to a local contact, Communicator looks for a match in the Telephony Directory and other available directories, and if a match is found, the available information is shown for the incoming call. If there is no match in the Telephony Directory, the display name is taken from the available information in the incoming call.

Whenever you retrieve your call logs/history, Communicator does a lookup in the local contacts and populates the name if a match is found.

7.5 Missed Call or Communication

When you have one or more missed calls or other types of communications, there is a notification on the left-hand side of the navigation pane in the Main window. Clicking the icon takes you to the missed communication in the Communications History view.

7.6 Full Screen in Video Call

Full screen mode can be activated by clicking the Full Screen button or by double-clicking anywhere on a video.

Exiting full screen mode is done by pressing the Esc key (on both Windows and Mac OS) or by double-clicking the window. Exiting full screen makes the video call go back to its original state (even if there was resizing of the window previously before going full screen).

In a full-size window, you can see a similar Options menu at the top. It has the same functionality as it does in the normal view. When you move the mouse, the top bar and lower communication buttons appear on top of the video.
7.7 Multiparty Sessions

You can have many participants in a call, either in a My Room or in an ad hoc multiparty call (native Desktop only). Add more participants by dragging and dropping them on to the Communications window or by selecting the Conference menu item via the Communications window menu button. By choosing the menu item, you can also add participants with just a telephone number. Starting with Release 22.2.0, ad hoc multiparty calling is slightly different in that each call party must be separately merged onto the call to be able to terminate failing calls to, for example, voice mail.

In contrast to using My Room, which uses your permanent chat and collaboration rooms and conference bridge, you can start ad hoc multiparty sessions by either selecting multiple contacts on the contact list and starting a chat, by calling them, or by expanding a one-to-one session into a multiparty session by dragging and dropping a contact into the Communications window. In an ad hoc session, the room used is a temporary one that is deleted once the session ends (that is, when the last participant leaves). Voice conferencing does not use a bridge but instead uses the BroadWorks N-Way Calling supplementary service in a sequential fashion. Communicator dials out to all participants and takes everyone off hold after the last attendee answers.

In newer deployments with the Video Server (UVS), the ad hoc room created for the session has a limited lifetime and becomes inactive when idle for too long. In this case, participants are able to rejoin the ad hoc session if they drop out for some reason. A consequence of this is that, in ad hoc group calls, participants who are no longer in the call are still visible in the participant list.

If the XMPP service is not available, then ad hoc multiparty calls are not available.

7.8 Call Waiting

You can have one active call at any one time if you receive a new incoming call and accept it. The existing call is put on hold and you can change between these two calls by using the Hold and Unhold buttons.

If Call Waiting is in the ringing state then new incoming calls are rejected.

7.9 Call Transfer

Blind call transfer is available in the Communications window; choose the Transfer Call menu item to transfer the call to someone else (native Desktop only). Attended call transfer is also available in the same window, first call someone to check if the called party can take the incoming call and then transfer the incoming call to the desired called party. You can also search for the transferred-to party.

7.10 Message Waiting Indication and Visual Voice Mail

Depending on your service provider settings, you can have either Visual Voice Mail (preview feature) or Message Waiting Indication (MWI) view in your client.

The MWI service allows you to receive a notification for a waiting voice mail or video mail. By clicking on the message icon in the upper part of the Main window, Communicator calls the predefined mailbox number to allow the user to listen to the voice mail or view the video mail. With this view, you only have two history tabs: one for calls and another for chat.

It is also possible to call voice mail from the dialer by long pressing the “1” icon in the dialer.
When visual voice mail is enabled, a third tab is available, showing visual voice mails. Click on individual mails to listen to them. Video mail is supported as a preview feature if enabled by your service provider. The current design is that listening to the visual voice mail or marking it as read decreases the unread messages badge while just doing a single click does not. Visual voice mail view also indicates if the message is urgent or confidential.

Missed calls are indicated by an icon in the Main window. Missed video and audio calls are indicated with a different icon. Note that the MWI icon is in the same place when it indicates a new voice mail.

Visual voice mail is also supported when enabled by your service provider. You can see all voice mails in a list and play them inside the Main window.

The following settings are needed on CommPilot portal to have visual voice mail:

- Voice messaging enabled
- “When message arrives, use unified messaging” option enabled
- “Use Phone Message Waiting Indicator” option enabled

Auto-deleted voice mails are cleaned once a day.

### 7.11 Call Park and Retrieve

Call Park is particularly suited for shared environments where one person can answer the call, park it, do something else for a while and continue the call from another device or let somebody else continue the call (supported on native Desktop only).

Transfer an ongoing VoIP call to a Call Park server and then retrieve it when needed. An ongoing call can be parked against your own number or another number (an extension). Call Retrieval works in the same way, the parked call can be retrieved from your own number (an extension) or another number (an extension) to provide flexibility for who is picking up the parked call.

A parked call is visible on your desktop in the Active Communications area so that you can easily retrieve it, but only for the duration of the BroadWorks Call Park announcement. After the announcement is over, the parked call disappears from the Active Communications area (since the triggering call is disconnected). After the call disappears from the Active Communications area, the user must remember the extension to which the call has been parked to retrieve it using the Main window menu (or feature access code), unless the call was parked to the one’s “own” extension. If the call is not retrieved after a certain time, then the server calls the parking user.

### 7.12 Call Pull

Call Pull allows you to pull an ongoing call from one of your devices to another one where the Call Pull feature is used (native Desktop only). Call Pull can also be used with FACs, in this case, *11. User interface support has been added to the Desktop so that an end user does not have to remember FACs. Release 22.2.0 added support for the Call Pull button for Xsi calls as well.

### 7.13 Call Recording Controls

You can use call recording controls in this release (native Desktop only). Depending on your service provider’s configuration, call recording can be initiated when a call starts or dynamically during a call (and start, stop, pause controls may be available). Additionally, there is an audio indication that call recording is ongoing as well as a visual indication. Feature Access Codes can also be used to control call recording when enabled in the configuration.
Recorded calls are accessed outside of Communicator; that is, you cannot view them using the client.

Depending on your service settings, call recording behavior is one of the following (this cannot be controlled in the client but in the self-provisioning portal):

- **Always** – recording indication (icon) in the *Communications* window as well as the *Active Communications* UI.
- **Always with pause/resume** – recording indication (icon) in the *Communications* window as well as in the *Active Communications* UI (only pause/resume menus available).
- **On demand** – recording indication (icon) in the *Communications* window as well as the *Active Communications* UI (no stop menu available, only start and pause/resume). After a call is established, call recording starts on the server. If the user presses the **Start Recording** button during the call, the call recording is stored and the server keeps the recording of the whole call regardless of when the recording was started (except for pauses). Otherwise, if no start recording is initiated from the user, the call recording is deleted from the server.
- **On demand with user-initiated start** – recording indication (icon) in the *Communications* window as well as the *Active Communications* UI (menu options available for start, stop, and pause). Call recording can be initiated at any time and several times during a call. There are separate call recordings for each call recording startup.
- **Never** – no indicators or menu options present.

Pause/resume audio indication depends on your service provider settings. It is recommended to log back in after changing the call recording mode in the self-provisioning portal.

### 7.14 Moderator Controls

You can control the functionality available to participants if you are the owner of the session in My Room. You can do the following:

- **Dismiss one or more participants.** This ends all sessions (group chat, audio, video, and share) when the participant is using Communicator for Desktop.
- **Mute one or more participants.**
- **Lock or unlock the room** (when locked, no additional participants can join).
- **See active talker indication.**
- **See full audio participant list.**
- **Choose who can join without separate authorization (moderated My Room):**
  - Require only guests to request access
  - Require everyone to request access
  - Allow everyone to join automatically

To invoke the features, you can use the right-click menus or you can click on the moderator control icons of a participant. Note that most features are not available via icons. To dismiss or mute all participants or lock the room, use the right-click menus available for your own icon at the top of the participant list.

If you are not the owner, you can only see the XMPP (chat) participant list or the full participant list along with mobile participants (depending on your service provider settings).
7.15 Forced Logout

Depending on your service provider settings, you may see a pop-up saying that you have been logged out due to another instance of the client logging in (native Desktop only). This feature allows BroadWorks to track similar online client instances and only allow one of them to be online at the same time. When BroadWorks notifies the client to log out, all connections are terminated and client returns to the login window.

7.16 Echo (Test) Service

Use this Main window menu option to make a test call to verify voice and video quality. The echo service asks you to record a message and plays that message back immediately before hanging up. The echo service may be available in different languages depending on your service provider settings.

7.17 Headset Support

You can control incoming and ongoing calls from a compatible headset. The feature set supported is answer/hang up as well as mute/unmute. Volume control operations are not reflected in the Communicator UI. The following is a list of tested example devices, although other devices should also work:

- Plantronics Voyager Edge UC
- Plantronics Savi 700 series
- Plantronics Blackwire C3xx, C4xx, C5xx, and C7xx
- Plantronics Calisto 620
- Plantronics Voyager Legend UC
- Logitech H570e Mono
- Logitech BCC950
- Logitech Conference Cam Connect
- Jabra Biz 2300/2400
- Jabra Speak 510
- Jabra Pro 930 (wireless)
- Sennheiser SC 230/260
- Sennheiser SP 20
- Sennheiser MB Pro1 UC

For a complete list of tested devices, see the BroadSoft Partner Equipment Interoperability Summary available on Xchange:

https://xchange.broadsoft.com/node/464941

Headsets typically use an add-in of some kind to communicate with the rest of the client while calls are made. Currently, installed add-ins are visible from the Preferences Add-ins tab.

In addition to the standard HID Add-in developed by BroadSoft, headset vendors can develop their own add-ins that can replace the BroadSoft Standard HID Add-in for all devices. Some of these add-ins (for example, Jabra or Sennheiser) cannot be used at the same time with the standard HID Add-in so either the BroadSoft Standard HID Add-in or the vendor-specific add-in must be disabled via Preferences in the Communicator client if one of the two is not automatically disconnected. Add-in installers should copy the required add-in dlls into the UC-One add-in folder so they become visible in Preferences.
These vendor-specific add-ins are typically installed during new headset installation; however, the BroadSoft Standard HID Add-in should remain in the preferences list. If for some reason it has disappeared, adding the respective .dll file back to the add-in folder should make it visible again in the Preferences. If later on you want to change to another headset, the vendor-specific add-in could be disabled from Preferences to again use the standard HID or some other new add-in by another headset provider. Re-login is necessary to take the new add-in into use.

Some USB headsets may have additional functionality offered by the vendor-specific add-in such as answering the call directly when taking the USB headset off dock. See the USB headset documentation for details of such functionality.

If you are using many different headsets, the BroadSoft Standard HID Add-in offers a default add-in that can always be used.

The following is the default add-in folder location (note that it is not possible to write to this location in all systems):

- Windows 7/Windows 8/8.1/10: C:\Program Files (x86)\BroadSoft\UC-One\connectors

Uninstallation does not remove add-in DLLs. In general, the following steps could be followed with third-party add-in DLLs.

1) Make sure that both UC-One and the third-party add-in are installed.
2) Go to UC-One → Preferences → Extensions.
3) Enable your add-in of choice, either USB Device Add-in by BroadSoft or a USB headset vendor-specific one.
4) Restart UC-One to take the changes into use.

7.18 Team Telephony

Team Telephony is comprised of a Team Telephony window showing the predefined team members and their related call states (native Desktop only). For a ringing call, the only action is to pick it up.

Each Team Telephony member can have four call states: available, busy in call, ringing, and offline. The status for a Team Telephony member is shown in the Team Telephony window. When a line is ringing, you can see the caller ID in the respective lines tooltip if configured by your service provider. All team members can see the full list of team members in the Team Telephony window. A double-click on the team member performs the default action towards the contact. You can drag and drop people from the contact list to the Team Telephony window or vice versa to transfer or conference calls.

The corresponding server-side service must be provisioned and assigned by the service provider for the client to work. Usual call management options are available once the call has been answered.

7.19 Executive-Assistant

The Executive-Assistant service allows an assistant to operate on behalf of an executive to screen calls, answer calls, and place calls as the “executive” (the caller ID is the one of the executive) (native Desktop only). The provisioning of the executive and assistant roles takes place on the server side and cannot be modified on the client.

One assistant can have many executives and it is possible to:

- Select the desired role when making a call using a pull down menu in the Main window.
Answer an incoming call on behalf of an executive and then push the call to the executive. The incoming call is presented as a call to the executive. In addition, all the usual call management options are available.

See that an incoming call is actually for the executive.

The caller ID format is dependent on your service provider settings and cannot be changed on the client side.

7.20 Presence Rules and Silent Alerting

Starting with Release 21.2.0, you can combine call processing with presence statuses (native Desktop only). For instance, the “Busy” status can be combined with Call Forwarding so that when the “Busy” presence status is used, calls are forwarded. It does not matter how the presence status is invoked, via automation or manually.

All presence statuses can have presence rules:

- Available
- Busy
- Away
- Offline

The following BroadWorks call processing services can be used:

- Silent alerting
- Call forwarding to number
- No rules

If presence rules are used, all your client devices should have this service enabled to avoid side effects. Silent Alerting is supported whenever an incoming call has that feature enabled. Silent alerting can only be enabled via presence rules in Communicator but various settings can also be altered via web provisioning.

7.21 Personal Assistant

Starting with Release 22.5.0, when enabled by your service provider, Personal Assistant allows you to use and configure additional predefined presence status to specify how long the status is enabled, what is the call transfer number for incoming calls during that status, and if ring splash is used.

Ring splash (Silent alert) plays a short audio tone on your desk phone when an incoming call is transferred. Your presence status with its duration is also played out to the caller when these additional presence statuses are used.

Supported new statuses are:

- Business Trip
- Gone for the Day
- Training
- Lunch
- Meeting
- Temporarily out
- Out of Office
- Unavailable
Vacation

When the duration for the selected presence state is set to last “End of day”, Communicator sets the expiration to the next day in the morning at 8 A.M. (0800 hours). Note that your OS locale defines the language in which the day is shown in the Personal Assistant status “Gone for the Day”.

The following table depicts the default validity times for the presence statuses.

<table>
<thead>
<tr>
<th>Presence Status</th>
<th>Default Duration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Trip</td>
<td>End of the Day</td>
</tr>
<tr>
<td>Gone for the Day</td>
<td></td>
</tr>
<tr>
<td>Training</td>
<td></td>
</tr>
<tr>
<td>Lunch</td>
<td>1 hour</td>
</tr>
<tr>
<td>Meeting</td>
<td></td>
</tr>
<tr>
<td>Temporarily Out</td>
<td></td>
</tr>
<tr>
<td>Out of Office</td>
<td>Never</td>
</tr>
<tr>
<td>Unavailable</td>
<td></td>
</tr>
<tr>
<td>Vacation</td>
<td></td>
</tr>
</tbody>
</table>

Note that contact list entries do not show the end time, by default, but you can see the information using tooltips (that is, by hovering over the contact).

Release 22.7.0 added support for the “Alert me first” option where you can specify how many rings the incoming call alerts in your Communicator client before proceeding to follow the Personal Assistant rules. Additionally, depending on your service provider settings, the “Silent alert” setting (ring splash) may or may not be hidden when you are managing Personal Assistant statuses such as “Gone for the day”.

7.22 Call Center Agent Login

Starting with Release 21.2.0, you can also log in to your call center queues if you are a call center agent (native Desktop only). You can do the following:

- View your call queues.
- Join your call queues.
- Set the Automatic Call Distribution (ACD) status so that you get incoming call center calls. However, this is dependent on your license settings.

With suitable ACD status such as “Available”, incoming calls to the queue are routed to your client. With “Unavailable” ACD status, the BroadWorks Do Not Disturb (DND) state can also be selected or “Personal Call”. Each ACD status indicates with text if you are to receive incoming call center calls.

Dynamic ACD status updates are not supported if the ACD status is changed somewhere else.
7.23 Remote Control Event Package

Remote Control allows you to answer a call, put it on hold from a receptionist, or call center client while the results are seen in your Communicator Desktop client. Answer and hold/resume buttons are visible in Receptionist/thin client to perform call management operations.

This feature must be enabled by your service provider for it to be used.

7.24 Auto-Answer

Release 21.5.0 introduced support for auto-answering incoming SIP calls for call center scenarios. The incoming call notification is identical to the usual incoming call notification.

7.25 Web Pop

Starting with Desktop Release 21.6.0, web pop allows you to get more information about an incoming call by clicking on the web pop button of the incoming call toaster. You can also do the same for outgoing calls using menus.

This opens your default web browser with a predefined URL that provides more information about the other party.

You can also change this URL in Preferences, if allowed by the service provider.

This feature is not available for Team Telephony or the assistant in Executive-Assistant calls.

7.26 Hide Communications Window Notifications and Tones

Depending on your service provider settings, Communicator notifications and tones in the Communications window can be hidden.
8 Application or Desktop Share

To share your desktop or individual application:

1) In the Communications tab, click the Start Share button. This does not yet start the “share”.

2) Select either to share your entire display or one of your open applications and click Start Sharing.

   The share widget appears to let you control share settings such as Preview that shows you what participants are seeing and Pause that pauses sharing.

3) To stop sharing, click the Stop icon. While sharing, all other communications mechanisms are also available except for video calling and file transfer. Participants cannot hide a share without closing the Communications window. Video call is also available while sharing.

Desktop sharing works the same way in both My Room and in ad hoc sessions. For participants without Communicator, use the separate Desktop Share Invitation link, if available, by right-clicking the My Room button. Share selector is not dynamically updated while the selector is open and minimized applications are not available in the list of applications to share.

As a participant, you can also zoom in and out during the share. As the share owner, incoming message toasters are suppressed during share, but the missed message badge is incremented and the incoming message sound is played when enabled.

If you are first in a video call and then start share, your own video is not shown due to limited space available, but you can make it visible using the Main window menu in the bottom right-hand corner by selecting “Show Own Video”.

If you are using dual monitors, you can choose which monitor to share. You can check the primary monitor in the operating system settings.

You can also remove desktop share participants. They are also removed from the group chat at the same time. If needed, the removed participants can join later.

Depending on your service provider settings, you may have to provide desktop share credentials manually.

In addition, participants can share when enabled by the service provider by clicking on the Share button; however, the room owner can prevent this at any time. Only one person can share at any one time in a session. Only one share at a time is supported if you have sessions with many users at the same time. Share passing is only supported in My Room.

Participants do not have to take any action to accept the share invitation. It is automatically accepted. The same also applies to share passing. That is, the owner does not have to take action for the participant to start sharing.

When video and share are used at the same time, the different views cannot be resized. Instead, the primary view can be selected from the bottom of the window via thumbnails.

In deployments using the older web collaboration solution, clicking the Share button opens an external browser window where share can be viewed.
9 My Room

My Room is started by clicking on the My Room icon on the top right-hand side of the Main window. My Room is started automatically using your permanent chat room. Add more participants by dragging and dropping them into the Communications tab or the Conference menu. Otherwise, they can join your room by right-clicking your name on their contact list and choosing the Join Room menu option. Once people have joined the chat room, they can click on the Call button of that window to join the conference. The room owner can also share their desktop.

To use the full functionality of My Room (desktop sharing, conferencing, and chat combined), you may have to manually enter your desktop sharing credentials, your conferencing number, and your PIN in the Preferences → Credentials window. This depends on your service provider settings.

In addition to the owner of the room, participants can also share the desktop but only the owner can add more participants. This applies to both My Room and ad hoc sessions.

1) To see a Context menu, right-click the Options icon (three dots) on the right-hand side of the My Room tab for Room Info.

2) To modify credentials and conference bridge information, select Configure to go to the preferences. If your service provider has automatic provisioning enabled, then this menu item is not present.

3) Select Copy Guest Link to copy an invitation link to the operating system clipboard (depending on your service provider setup, this menu option may not be available). Paste this link, for instance, to a meeting invitation email to allow Communicator participants to join the conference in one click from, for example, Outlook, or Office applications. Note that some applications may not recognize the Communicator (btbc:) link. You can also copy the My Room Invitation to the default email client (this text does not contain the Communicator link) and go to the My Room preferences via a right-click menu option.

The link has two parts: one for Communicator users and another one for users with some other client. Depending on your service provider settings, the invitation can also contain a link to the desktop sharing session. The invitation always contains a dial-in number and PIN for users who do not have Communicator. The desktop share link, when available, allows anyone to join a desktop share session from a standard web browser. In addition, the Communicator group chat session is supported with the web collaboration session. For guest user links, see the next section.

The My Room info area indicates the conference bridge details of your My Room. You can also export the attendee list using the related participant menu available via the options icon (three dots).

The Communications window also has an icon that provides the same Context menu previously discussed.

For more information on desktop sharing, see section 8 Application or Desktop Share. Desktop sharing works the same way for both My Room and the ad hoc sessions.

My Room uses your permanent chat room, permanent collaboration room, and conference bridge (audio or video). My Room is the only way to use the permanent rooms. Any other multiparty communications, such as selecting multiple contacts, and right-clicking for a conference call, or dragging and dropping for a one-to-one chat, is done using ad hoc rooms. Ad hoc rooms are deleted once the session is over.
All My Room sessions start as chats but call and/or share can be added to the session while in progress. File transfer and video conferencing are not supported in My Room or ad hoc sessions, additionally, you cannot transfer or conference My Room calls.

You can also define that all users or only guest users need to be authorized to access My Room or that all users can automatically join. My Room invitations sent by you cannot be canceled in this release.

My Room calls cannot be conferenced or transferred.

9.1 Guest Client

Previously it was not possible to join a full My Room session with a web browser. Guest client allows you to do that.

This feature is especially intended for users outside of the company. Generate separate invitations for guest users using My Room right-click menu items as described in the previous section. My Room invitations are generated using separate menu items and are intended for Communicator users.

Guest users can join a session with audio in the web browser by requesting a callback using the provided dial-in number and conference PIN as well as use group chat and sharing inside the web browser. However, guest clients do not have private chat possibility and they can see the chat history of messages that occurred after they joined the session.

The invitations persist until reset via a separate right-click menu item. Individually accept each joining guest participant. Not doing this in a predefined period of time results in the invitation becoming obsolete and guests not being able to use the link to join. For more information, see section 7.14 Moderator Controls.

After dismissing a guest user from share and chat, the audio/video portion can remain.

The following OS and browser combinations are supported if Web Real-Time Communication (WebRTC) is disabled by your service provider:

- Latest Chrome on Windows (Windows 7, Windows 8 [Classic], and Windows 8.1 [Classic]) and Mac OS (10.8 and 10.9)
- Internet Explorer 11 on Windows (Windows 7, Windows 8 [Classic], and Windows 8.1 [Classic])
- Safari 7 on Mac OS (10.8 and 10.9.)

The following OS and browser combinations are supported if WebRTC is enabled by your service provider:

- Latest Chrome on Windows (Windows 7, Windows 8 [Classic], and Windows 8.1 [Classic]) and Mac OS (10.8, 10.9, and 10.10)

For more information on guest client usage, see Appendix B: Guest Client Usage.
10 Search

Communicator supports a search of the enterprise directory as well as the personal directory, enterprise common directory, and group common directory. This takes place in the same Search field that is used for both a local and presence-enabled contact list search. The various directories have different purposes with the enterprise directory having the most data, and not all directories may be used in all deployments. All search results are combined into one common set of results.

Personal directory, enterprise common, and group common directories cannot be modified from the client side. Only read access is provided. A snapshot of the presence status of the contact in the results list is shown, but this presence is not updated after the search operation.

Personal directory provides your own special contacts that are not in the enterprise directory, for instance, partner company's numbers while group common contains, for example, the group’s contacts such as favorite pizza taxi.

Communicator automatically searches the local contacts and presence-enabled contact list in addition to the enterprise and other directories at the same time. As soon as there are results from the enterprise and other directories, these results are shown on a separate list in the Main window. Additionally, there may be other search result groups from other search sources such as LDAP or Outlook (native Desktop only).

In a search, Communicator also supports Hiragana characters for the Japanese market.

Search results are displayed differently depending on the results of the contact list and directory search:

- If LDAP search (Corporate directory) or Outlook search are enabled, there are more result groups.
- If there are no results for a certain search source (for example, local contacts, Outlook, LDAP, or BroadWorks Telephony Directory), then that group is different in the UI.

The enterprise directory searches all available fields for the search string. By default, it waits for 1.5 seconds before it sends the search request to the server to minimize unnecessary load on the server.

Release 21.5.0 introduced support for showing phone number in the search results to better distinguish similar search results. In addition, ToolTips are provided for search results.

Release 22.4.0 added support for department and title in directory search results as well as multi-part search string enhancements depending on service provider configuration on the server side. The server will apply the AND operation for each search string part, and the order in which the individual parts are provided will not impact the search result. The enhancement applies all Xsi directories (enterprise directory, personal directory, group common, and enterprise common). For example:

- While looking for Philip Moorefield, the following search string can be used: “Phil Moore”. An exact match of the first name is no longer required.
- Looking for Joe Gold and using “jo go” or “go jo” as a search string provides the same results.
- If Gregory Evermoore has for instance an email address “gevermoore@company.com”, he can be found using “ge” as a search string.
Typically, when adding a contact using directory search results, there are phone numbers and first names in addition to last names available. In addition, the Extensible Messaging and Presence Protocol (XMPP) address and other fields are imported when found to allow presence and chat.

Release 22.7.0 added support for configurability of search results for virtual subscribers such as call centers. Depending on your service provider settings, the search results may look different in what kind of display name is shown for virtual subscribers.

LDAP search (Corporate directory) must be enabled by your service provider. In addition, depending on your service provider settings, you may have to manually provide your LDAP credentials in the Preferences → Security tab. LDAP search results are provided in the corporate directory group in the search results.

Outlook integration (search and calendar integration) on Windows requires one of the following versions installed on the desktop:

- Outlook 2010
- Outlook 2013
- Outlook 2016

Outlook search also works when several Outlook accounts are in use, but only one account is used at a time (default selected, which can be changed in Outlook). Additionally, other related considerations are as follows:

- The client searches for contacts and calendar entries in the default Outlook account. The account is set to the default via File → Info (left pane) → Account Settings → Account Settings → Data Files. Select an account and mark it as “Set as Default”. After making this change, sign out and sign back in to the client and it now searches that account for contacts and calendar entries.

- The client searches the Outlook contacts only on the local machine (that is, the Outlook Address Book). There is no Exchange server lookup performed. In addition, all directories in Outlook are searched for contacts, even deleted folders. The Contacts directory can also have multiple levels of subfolders.

Every minute, Communicator reads Outlook appointments. If there is an appointment running at the current time, then the presence is shown as Busy – In Meeting. Overlapping appointments are also handled. Following are some examples of Communicator operation with Outlook when time is 9:10 A.M.

- There is meeting “A” 9 A.M. through 10 A.M. Presence is shown as Busy – In Meeting.

- Presence is explicitly changed to Available at 9:15 A.M. Presence is shown as Available.

- In the next minute, Communicator again reads the appointments and sees that “A” meeting is running; however, the presence was already explicitly marked as Available and presence is not shown as Busy – In Meeting but Available.

- There is an overlapping meeting “B” 9:30 A.M. through 10:30 A.M. Presence is shown as Busy – In Meeting when the time is 9:30 A.M.

When deleting a meeting that is currently ongoing in Outlook, the presence status remains as Busy – In Meeting until the next time Outlook appointments are checked (once every minute) and after that, presence is shown as Available. This change may be instantaneous or it may take a minute depending on how close the timer is to being triggered.
The Outlook Object Security model was introduced in Outlook 2007; however, it is no longer supported in UC-One. It has been tested with Outlook 2010. For Outlook versions prior to 2007, the Allow/Deny pop-up window seen in previous releases should not be triggered. However, those versions are not officially supported. For Outlook 2013, the behavior should be similar to 2010, meaning the pop-up should not come up with Outlook 2010 and 2013 in Release 20.0.0 and onwards.

The presence update is only triggered by appointments and meetings that are either accepted by the user or made by them. All day meetings do not trigger a presence change to Busy – In Meeting.
11 Full Enterprise Directory

Communicator allows for browsing of an entire BroadWorks enterprise directory.

To view the BroadWorks enterprise directory, click the **Directory** button on the left-hand side of the navigation pane (if available). This feature depends on the service provider configuration so it may not be visible in all clients.
12 Communications History

The fourth icon from the top in the Main window on the left-hand side of the navigation pane displays your messaging history. History view is divided into one, two, or three tabs depending on your service provider settings. Possible tabs are:

- Calls
- Chat
- Visual voice mail

Double-clicking a conversation on the chat tab list opens it in a new window while double-clicking a call history item calls that number. Clicking a visual voice mail downloads the message so you can play it.

Communicator saves a call history for placed, received, and missed calls. The call history makes it easy for you to redial and call back when you have missed a call or you want to easily dial a contact with whom you have recently spoken. Each call has a separate entry in the list.

Chat history for group chats, both in My Room and in instant group chat, are stored locally on the Desktop client, just like in one-to-one chat, but only for the time the user is joined into the session. Look at individual chats by double-clicking the contact in the contact list or click the chat history icon in the left pane.

Double-click on a name in the list to call back directly (this calls back the same way you previously spoke, for example, if you were in a video call, double-clicking starts a new video call). Double-clicking an incoming call item in the Calls tab makes a call.

To clear the missed chat indicator, you must open the missed chat.

The Communication History missed communications badges can be cleared by using the right-click menu from the Communication History button on the left pane (native Desktop only). The menu provides options to mark “All as viewed”, “Chats as viewed”, “Voicemails as viewed”, and “Calls as viewed”.

Depending on your service provider configuration, call history may also display call duration as well as hunt group or other Call Forwarding information.

Release 22.5.0 added support for synchronizing the history items with configured directories so that the display name shown is as accurate as possible.
13 Click-to-Call (Highlight Text)

Release 21.5.0 introduced support for Click-to-Call using highlighted text and global keyboard shortcuts. Users can highlight text anywhere in the desktop machine to make a call and define the default call type used for making the call using the shortcut defined in Preferences. On Mac OS, you must define the shortcuts on your own using the instructions provided in Preferences. The order in which key combinations are pressed may be significant in some cases if the operating system has reserved some key combinations for other purposes.
14 Callto, Tel URL, and Other URL Schemes

You can use Communicator for making calls using Callto, and Tel URL links anywhere in your machine, but you need to register Communicator as the primary application for that purpose in the operating system. Additionally, depending on your service provider settings, other URL schemes may also work.

On Windows, at first login there is a dialog asking if you would like Communicator to be the primary calling application for Callto and Tel URL schemes. Answering yes will modify Windows settings so that the next call using those links will use Communicator. If another application should afterwards take precedence in Windows settings, you can again make Communicator the primary calling application from Preferences, Outgoing Calls tab.

On Mac OS, you must make the same selection in FaceTime preferences. You are required to log in to FaceTime to change the preferred calling application.
15 XMPP Security

Depending on your service provider configuration, Communicator supports blocking of unauthorized file types in file transfer in order to support service provider IT policies (native Desktop only). When sending a file with of an unauthorized type, there is an error message showing the cause of the file transfer failure.

Similarly, clickable links in chat may be disabled; however, you can still copy the link into a browser.
16 Web Button

As a service provider option for integrating third-party web content onto Communicator Desktop, up to four (Release 22.5.0 onwards) web button left pane icons may be visible. When clicked, it opens predefined content either in the Main window or on a separate web browser. Both single and multiple links may be present.

In addition, local applications can be used in the links, for instance, email. This depends on your service provider configuration.

Starting with Release 21.3.0, cookies are supported. The saved cookies are stored in cookies.dat that can be accessed from Preferences → General tab by clicking on the Open folder button and navigating one directory level up. To remove old cookies, first exit UC-One, then remove the file and sign back in. Failing to exit the client will result in recreating the cookies.dat with the cookies from memory.

Release 22.2.0 added support for opening web content onto a tab as well.
17 Outlook Add-in

17.1 Introduction

The Outlook Add-in for Communicator provides integration between Communicator Desktop and Microsoft Outlook and Microsoft Skype for Business (S4B).

With this add-in, you can have Microsoft Outlook display Communicator contact presence and invoke Communicator functions like chat, call from computer, call from phone, and video call from within Outlook.

Depending on your service provider settings, Presence is from either Communicator or S4B. Additionally, chat and SIP calls are done with either S4B or Communicator, depending on your service provider settings.

17.2 Supported Platforms

The following platforms are supported:

- Microsoft Outlook 2010 (32 and 64-bit), Microsoft Outlook 2013 (32 and 64-bit), and Microsoft Outlook 2016 (32 and 64-bit). See the following note for exceptions.
- Microsoft Windows 7 SP1, Microsoft Windows 8, Microsoft Windows 8.1, and Microsoft Windows 10
- Communicator Release 20.2.0.x or higher officially supported version.

NOTE: The current version of this add-in cannot be used if you have Microsoft Office Communicator or Skype installed. You must uninstall these products if you want to use this add-in. Skype for Business can be used at the same time.

Outlook 2010 cannot be used together with the S4B integration feature introduced in Release 22.3.0 for newer Outlook versions. Additionally, administrator rights are required for the Outlook Add-in except for Outlook 2010.

The following language and locale combinations are supported in the installer and the add-in:

- Chinese (Simplified)
- English
- French
- French (Canada)
- German
- Italian
- Japanese
- Korean
- Spanish
- Spanish (CALA)
- Portuguese (European)
- Dutch
The following third-party components must be installed for the add-in to function correctly:

- Microsoft .NET Framework 4 Client Profile
- Microsoft Visual Studio Tools for Office (VSTO) 2010 Runtime

These components are downloaded and installed by the installer if they are not found. They should not be uninstalled, as the add-in cannot function correctly. Additionally, for Outlook 2016 and the Outlook Add-in (OL2016 Add-in), there are further considerations as follows:

- The Outlook Add-in can only be installed by an administrator.
- If an administrator installs for all users and a normal user starts using the OL2016 Add-in, Communicator must start before Outlook.
- For logging to work normally, Communicator must start before Outlook.
- Every logging level change requires a restart of both Communicator and Outlook for changes to take effect. This should be quite rarely needed.
- If Outlook is closed while Communicator is running, Communicator must be restarted as well for the Outlook UI to behave as expected.

Communicator lists connected components as extensions, if connected is NO or if component version number is something other than 10.2.1.29, or both presence GW and add-in are not listed, an error has occurred. Component is visible under Options → Add-ins → UI, which displays registered and working add-ins on top, below stopped or non-working ones.

- If both are listed and show connected is YES, but the Outlook UI does not work, restart both apps.
- For Outlook upgrade requirements, see section 17.5 Installation.
- For Outlook 2010, all contacts must be updated to have a SIP address. For Outlook 2013/2016, the following applies:
  1) The SIP address does not need to be entered for the contacts, as long as there is an email address that matches the Outlook contact. The same value is looked for in the SIP address field, but it is probably more practical to have it in the email address.
  2) The Outlook Add-in allows you to choose which number to call.
  3) Two Outlook or Communicator contacts cannot have the same email address or IM address, otherwise full functionality cannot be guaranteed.

**NOTE**: Communicator must be installed with administrator privileges in C:\Program Files OR the C:\Program Files (x86) folder.

### 17.3 Log Files

Log files for the Add-in are located in the Communicator log directory. You can open the folder via Preferences → Advanced by clicking on the Show logs button. Outlook Add-in logging is turned on when Communicator logging is enabled.
17.4 Windows Registry Entries

The following table lists all the registry entries added or modified by the installer.

<table>
<thead>
<tr>
<th>Path</th>
<th>Key</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>HKEY_CURRENT_USER\Software\BroadSoft\Communicator\OutlookPlugin\olwnd</td>
<td>wnd</td>
<td>Keeps Outlook applications window reference.</td>
</tr>
<tr>
<td>HKEY_CURRENT_USER\Software\BroadSoft\OutlookPlugin</td>
<td>LoggingLevel</td>
<td>Logging level for Outlook plugin components. Its value as per Communicator Options → Advanced logging selection as follows: Basic logging on: 0x00000003 Detailed logging on: 0x00000005 Both off: 0x00000000</td>
</tr>
<tr>
<td>HKEY_CURRENT_USER\Software\BroadSoft\InstalledBrandedBTBC</td>
<td>Example,</td>
<td>These keys affect where the plugin is searched for when starting and where log files are written.</td>
</tr>
<tr>
<td>HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Office\Outlook\Addins\Communicator Add-in for Outlook</td>
<td>LoadBehavior</td>
<td>0x00000003, based on this value Outlook loads the add-in dll.</td>
</tr>
<tr>
<td>HKEY_LOCAL_MACHINE\SOFTWARE\IM Providers\Communicator</td>
<td>Description</td>
<td>Communicator Add-in for Outlook.</td>
</tr>
<tr>
<td>HKEY_LOCAL_MACHINE\SOFTWARE\IM Providers\Communicator</td>
<td>FriendlyName</td>
<td>Communicator Add-in.</td>
</tr>
<tr>
<td>HKEY_LOCAL_MACHINE\SOFTWARE\IM Providers\Communicator</td>
<td>Manifest</td>
<td>$INSTDIR\plugins\Outlook\OutlookBrandedBTBC\UC-Outlook-addin.vsto</td>
</tr>
<tr>
<td>HKEY_CURRENT_USER\Software\IM Providers</td>
<td>DefaultIMApp</td>
<td>Communicator</td>
</tr>
<tr>
<td>HKEY_CURRENT_USER\Software\IM Providers\Communicator</td>
<td>UpAndRunning</td>
<td>0x00000002</td>
</tr>
<tr>
<td>HKEY_LOCAL_MACHINE\SOFTWARE\IM Providers\Communicator</td>
<td>FriendlyName</td>
<td>BroadsoftIMApp</td>
</tr>
<tr>
<td>HKEY_LOCAL_MACHINE\SOFTWARE\IM Providers\Communicator</td>
<td>GUID</td>
<td>(E3D1613A-93B2-4237-B4B8-B50595462C25)</td>
</tr>
<tr>
<td>HKEY_LOCAL_MACHINE\SOFTWARE\IM Providers\Communicator</td>
<td>ProcessName</td>
<td>presencegw.exe</td>
</tr>
<tr>
<td>HKCU\Software\IM Providers\DefaultIMApp</td>
<td>UC-One Application</td>
<td>Needs to be taken by Communicator to be able to call, for example, call PSTN numbers from Outlook.</td>
</tr>
</tbody>
</table>
17.5 Installation

The Outlook Add-in installation is integrated with the Communicator installation. There is a check box in the installer to enable the Outlook Add-in installation. If Outlook is upgraded, the Outlook Add-in must be re-installed, since the Add-in uses different files depending on the Outlook version.

The Outlook Add-in installation requires administrator rights to the computer for all Outlook versions.

17.6 Features

17.6.1 Presence in Outlook

The Outlook Add-in displays the presence of a contact in Outlook. Presence information is retrieved from Communicator and is displayed as an icon next to the contact in emails and calendar appointments. The following is an example of an email with the To, From, and Cc fields showing presence for various contacts.

![Email with presence](image)

Figure 2 Presence Displayed in Outlook

A contact’s presence can be Available, Away, Busy, or Offline as shown in the following figure.

![Presence Values](image)

Figure 3 Presence Values

**NOTE:** You must be signed in to Communicator for the presence to be displayed. Additionally, presence is only shown for contacts that have a valid SIP address and are in your contacts list in Communicator.
17.6.2 Contact Actions in Outlook

Right-click on an email in your Inbox and call or chat with the sender using Communicator. You have the option to Chat, Call (from Computer), Call from Phone, or Video Call as shown in the following figure.

![Contact Options Figure]

**NOTE**: Some of these options may not be available for all contacts. The chat option is only applicable to contacts that are in Communicator. Call options are applicable to all contacts as long as they have a valid phone number.
These contact actions are also available on a contact card as shown in the following figure.

![Contact Card](image)

Figure 5  Contact Card

17.6.3  Call Multiple Phone Numbers Configured for Communicator / Non-Communicator Contacts

You can call any of the multiple phone numbers present in the Outlook contact card. This feature is available from received mail context menu, flagged mail context menu, and Contact’s context menu. You can also call the selected phone number via Call, Call from Phone, and Video Call.

However, you cannot call multiple numbers for contacts stored on the UC-One client or contacts in LDAP (AD) directories; only numbers stored in Outlook.
See the following figure for an example of how to make the call from a received mail context menu.

![Received Mail Context Menu in Outlook](image)

**Figure 6** Received Mail Context Menu in Outlook

See the following figure for an example of how to make the call from the contact item context menu.

![Contact Item Context Menu in Outlook](image)

**Figure 7** Contact Item Context Menu in Outlook

### 17.7 Uninstall Outlook Add-in for Communicator

Uninstallation is done together with uninstallation of Communicator.
17.8  End-User Configuration

17.8.1  SIP Address in Microsoft Outlook Contacts

**NOTE**: This section is only applicable if you use Microsoft Exchange with Outlook. You do not need to configure the SIP address for SMTP-based accounts (for example, Google Mail).

In order for the Outlook Add-in to integrate with Communicator, you must set a SIP address for each contact. The SIP address for a contact in Outlook must match the SIP URI, Instant Messaging and Presence (IM&P) address, or Email field in Communicator. This is usually done by your Microsoft Exchange or Active Directory administrator.

You can check if a SIP address has been configured for contacts by looking at the Outlook properties for a contact. In Outlook 2010, open a contact card and then click on the View more options button as shown in the following figure.

![Outlook Contact Properties](image)

Figure 8  Outlook Contact Properties
Then select the *Email Addresses* tab. It should have a SIP address in the list of *Email Addresses* as shown in the following figure.

![Image](image1.png)

Figure 9  SIP Address for Outlook Contact

If the SIP address is missing, you can try to update the Address Book from the server as shown in the following figure.

![Image](image2.png)

Figure 10  Download Address Book

Additionally, when adding contacts from Outlook to Communicator, the IM address field can be populated in Outlook so that the presence feature can work directly on the Communicator side as the information is imported to the Communicator contact card.
18 CC-One Integration

Communicator Desktop Communications window can be invoked from CC-One. The exact appearance can be dictated by your service provider and in general UC-One can be hidden with some tones and notifications disabled.
19 UC-One Add-In for Microsoft Skype for Business

Communicator for Desktop supports integrating with Microsoft Skype for Business (S4B) (native Desktop only). The intended main use case is using Communicator for non-S4B calls such as calls to mobile while presence, chat, and S4B-to-S4B calls still take place via S4B although full Communicator functionality can also be used. In Release 22.2.0 and later, a custom menu is available on the S4B side used to make PSTN calls.

Existing S4B integration with, for example, SharePoint, Office 365, and Internet Explorer can be used so that calls can be made from those applications.

Usual Communicator Call Control features such as hang up, mute, transfer, conference, and Call Park are supported. Communicator call logs and call settings are also available in this configuration.

Communicator also updates phone presence on the S4B side. If USB headsets are used, the BroadSoft Standard HID Add-in cannot be used at the same time when S4B is running but the standard HID will be automatically disabled. A vendor-specific add-in can be used instead.

Release 22.6.0 added support by automatically closing the Communicator window after a PSTN call has been completed, (when enabled by your service provider).

For detailed calling examples, see Appendix C: Skype for Business Integration. For a general overview of this feature, see the UC-One Add-in for Microsoft S4B Product Guide.
20 Emergency Calls

Depending on your service provider configuration, a number of options are possible:
- Emergency Call Address Change Service (ECACS) is enabled.
- Emergency calls are disabled.
- Banner used for conveying your emergency call location.
- Login dialog shown at login to inform you about your service provider’s emergency call procedures.

20.1 Emergency Call Address Change Service

Depending on service provider settings, a special dialog can be shown at login, asking if the (physical) address needs to be updated (native Desktop only). If not, login proceeds normally. If the user replies “yes”, a web browser opens with the possibility to update the physical address for emergency calls. Once the address update is complete, login continues.

Depending on service provider settings, a separate ECACS menu item may also be visible in the Main window. This menu item allows ECACS to be invoked at any time after login.
21 UC-One Hub

21.1 Introduction

Communicator Desktop supports UC-One Hub. It allows you to be more efficient and productive using various integrations with other applications such as:

- Google: Mail, Calendar, Drive, Tasks
- Office365: Mail, Drive, OneDrive, O365Tasks
- Outlook mail and calendar
- Box
- Concur
- Twitter
- Team-One
- Salesforce

You can use these applications without leaving Communicator to avoid scattered communications and fragmented workflows. A contextual gadget is available on the right-hand side of the Desktop Main window to provide you with a timeline of communications, emails, accessed attachments and files, locations, tasks, and meetings you have had with a particular contact, providing you with an aggregated view on notifications and interactions across various applications. You can also filter information stored in various applications based on context such as people, topic, and information type.

In the Desktop Main window, you can also view integrated applications such as Google Drive or Concur. See the following figure for an example. Contacts are in the left, real-time communications in the middle, and application integration on the right. The icons for enabled integrated applications are in the Hub banner of the bottom left-hand side. Clicking on one of the application icons opens data from that application onto the Main window in place of the contact list.

![Figure 11 Desktop Main Window](image-url)
BroadSearch is available for all apps to search for content inside that app.

Before you start using UC-One Hub, you must select your applications:

- Click the UC-One Hub button to access the UC-One Hub service.
- Select applications for the micro-app view and the contextual pane from Settings.
- Upon first login, all applications will be disabled.

To authorize, enable, and configure an application:

1. Click on the slider next to an application. A browser window opens asking for the user's application credentials (for example, Gmail).
2. Authorize UC-One Hub to link to the selected application.
3. Contextual information (Call Information check box) and notifications (Notifications check box) are selected by default.
4. Hovering over an application in Settings shows your email address followed by a Logout link and the Notifications check box.
5. You can enable/disable notifications by checking/unchecking the Notifications check box.
6. Once notifications for an application are enabled, an application icon and a notification count appear at the bottom of the Main window.

21.2 Hub Banner (Micro-app) View

UC-One Hub banner in the Main window provides quick access to favorite applications, such as Gmail, Google Calendar, Google Drive, Twitter, and so on. You can take quick actions on these applications directly from UC-One Hub’s banner view. Each micro-app in the banner is enabled by a centralized authentication process described in the previous section.

Each enabled micro-app is auto-refreshed with a built-in notification mechanism that keeps track of updates such as new emails, upcoming calendar events, and so on, so that you always have the most up-to-date information.

Some example applications are listed in the following subsections.

21.2.1 Google Calendar

Displays upcoming calendar events:

- Today
- This Week

Quick Actions are available when hovering over a calendar entry, including:

- Accept
- Decline
- Tentative
- Launch in browser (actual Google Calendar)

The Notification counter shows the number of upcoming events in 30 minutes.

21.2.2 Gmail

Displays email filters based on:
Quick Actions are available when hovering over an email. The following quick actions are supported:
- Mark As Read
- Delete Email
- Archive
- Launch in browser (actual Google Gmail)

The Notification counter shows the unread emails counter.

21.2.3 Google Drive
Displays Google Drive’s Recent, Unread, and Shared with Me files.
Quick Actions include “Launch in Browser”.
The Notification counter indicates unviewed files.

21.2.4 Google Tasks
Displays your tasks.

21.2.5 Box
Displays, for example, access to your Box folders.

21.2.6 Concur
Displays your pending and approved Concur reports.
Quick Actions are available by hovering over a report on the list, including:
- Launch report in browser

21.2.7 Microsoft O365 Mail
Displays email filters based on:
- All
- Archived
- Unread
- Today
- Inbox
Quick Actions are available when hovering over an email. The following quick actions are supported:
- Mark As Read
- Delete Email
- Archive
Launch in browser (actual Google Gmail)
The Notification counter shows the unread emails counter.

21.2.8 Microsoft O365 Calendar
Displays upcoming calendar events:
- Today
- This Week
The following Quick Actions are available:
- Cancel event
- Open in actual O365 Calendar
The Notification counter shows the number of upcoming events in 30 minutes.

21.2.9 Microsoft O365 OneDrive
Displays OneDrive All, Recent, or Shared with me files. Quick Actions include “Share” and “Open in OneDrive”.

21.2.10 Microsoft O365 Tasks
Displays your tasks.

21.2.11 Microsoft Outlook Calendar
Displays the same items as O365 calendar.

21.2.12 Microsoft Outlook Mail
Displays the same items as O365 mail.

21.2.13 Twitter
Displays filters for Twitter home view, My Tweets, Retweets, and Mentions.
Quick Actions are available by hovering over a tweet on the list, including:
- Retweet
- Favorite
- Launch in browser

21.3 Contextual Gadget
Contextual intelligence helps find and filter relevant information to enhance your productivity.
The contextual pane appears in collapsed form on the right side of the main window when a chat tab is opened. The pane is dynamic showing server-side content and changes based on the remote user and any mutually shared information.
For example, you are in a UC-One Hub chat with remote user B, and you can see in the contextual pane information shared between both users such as emails, files in cloud storage, and so on.
The BroadSearch engine is available for all apps, providing instant refinement of information shared with a remote user; it instantaneously executes its algorithm based on every character entered in the search field. For example, with Gmail, it searches the emails matching the search string.

It also inherits the search string and performs an auto-search when applications are switched.

21.3.1 Gmail

Shows recently shared emails and attachments between the user and a remote user in communication. Emails can be viewed from the Emails or Attachments filters.

Provides same quick actions when hovering over an email as in micro-app:
- Mark As Read
- Archive
- Delete Email
- Launch in browser (actual Google Gmail)

21.3.2 Gmail and Google Drive Files

Google Drive and Gmail attachments are filtered in respective tabs. The Drive tab lists Google Drive files shared between you and the remote user. The Gmail tab shows Gmail attachments shared between you and the remote user.

21.3.3 Twitter

Twitter feeds are listed under the Social filter, showing recent tweets of the remote user. The mechanism of fetching a remote user’s Twitter handler is based on the Google Contacts custom field.

21.3.4 Google Calendar

A filter with upcoming meetings is provided. Additionally, it is possible to schedule a meeting.

Same Quick Actions are available as in the micro-app:
- Accept
- Decline
- Tentative
- Launch in browser (actual Google Calendar)
22 Forced Configuration Update

Depending on your service provider configuration, forced configuration update can be supported. When enabled, you will be prompted to log in again when the configuration has changed. This will not happen however if you have ongoing calls, share, or group chat sessions.
23 Password Change

A dialog box automatically opens when your login password must be changed (native Desktop only). You must provide the password two times for verification purposes. Using a menu in either the bottom right-hand corner or the top of the Main window, your password can be changed at any time.
24 Privacy Policy

If you want to read the service provider privacy policy that can be done by clicking the privacy policy link available in the About view when enabled by your service provider. If you service provider has not enabled the link, it will not be present in the About view.
25 Accessibility Compliance

Communicator supports accessibility compliance starting with Release 21.3.0 by having all client features available in menus at the top of the Main window (native Desktop only). The menu items are also available using the keyboard shortcuts listed in Appendix A: Keyboard Shortcuts for Desktop.

Release 21.6.0 added support for the following features:

- Dictation
- Screen reader (VoiceOver on Mac OS)
- Keyboard navigation

The following limitations apply:

- On Mac OS by default, the tab key moves the focus between text-inputs and lists. This can be changed through System Preferences → Keyboard → Shortcuts. Under Full Keyboard Access, select “All Controls” instead of “Text boxes and lists only”.

- Dictation on Mac OS: If WebRoot SecureAnywhere is used, Pause Secure Keyboard Entry must be selected.

- Users must manually select the correct language in screen reader. UC-One does not force screen reader's language according to the language selection in the client.

- On Mac OS, the VoiceOver focus follows the VoiceOver Cursor. When VoiceOver is enabled, users are expected to navigate with the VoiceOver Cursor. That can be enabled through System Preferences → Accessibility → VoiceOver → Open VoiceOver Utility. In the opened window, open “Navigation” and check “Keyboard focus follows VoiceOver cursor”.

- When using VoiceOver on Mac OS with different languages, the OS language, client language, and VoiceOver language must all be the same.

Recommended Preferences → General → Accessibility settings for screen reader/VoiceOver are:

- ToolTips disabled
- Pop-up errors enabled
26 Google Analytics

UC-One Communicator can send analytics data to your service provider and/or BroadSoft to improve the service. You can enable and disable this option in Preferences.
27 Personal Identity Verification Support

Communicator Desktop supports Personal Identity Verification (PIV) on Windows only. If you have a PIV card and the associated card reader is attached to your PC, you can log in to Communicator by only providing a PIN related to your PIV card.

It is possible to first use Communicator in non-PIV mode and later in PIV mode if your service provider has enabled this.

Other Communicator functionality is not impacted.
28 Federal Information Processing Standard Compliancy

Communicator can also be deployed in Federal Information Processing Standard (FIPS) compliant mode if enabled by your service provider. In this mode, all encryption is done in a FIPS-compliant way. All functionality except the following is available:

- UC-One Hub
- Banner
- Web button
29 IPv6 Support

Release 22.4.0 added support for IPv6 as a preview feature and Release 22.5.0 as an official feature. IPv6 usage depends on your service provider.
30 Preferences

Preferences provide access to available settings for Communicator. Follow these steps to access Preferences.

Windows and Mac OS
1) Click the Preferences logo in the Main window left pane.
2) Select the desired view from the drop-down.

or

Windows and Mac OS
1) Go to the Communicator accessibility menu.
2) Select Preferences.
3) Select the desired view from the drop-down.

30.1 General

Language
Select your language then click OK or Apply and the change takes effect immediately. Note that the number of languages depends on your service provider.

Login
Enable or disable automatic login when starting the application and control the remember password feature as well as enable the Update Password feature.

Notifications
Usually there is a confirmation pop-up notification each time you remove a contact or chat history record. By selecting one or all of the check boxes, you can disable the confirmations when deleting information. You can also control whether there is always a pop-up notification for publishing location information. Typically, this is shown at login. You can also select whether to receive a notification before ending communication or holding a call.

Accessibility
Enable pop-up errors allows Communicator error pop-ups to be shown in addition to the usual error text shown at the top of the Main window.

Enable ToolTips is enabled by default. For accessibility, screen reader/VoiceOver reads all ToolTips, which may be frequent and hence disturbing. For this reason in accessibility cases, it is recommended to disable ToolTips.

You can also enable spell checking and auto-capitalization.
30.2 Audio/Video

30.2.1 Audio

Headset
Here you can specify what are the output and input devices used for the headset when toggling between the headset and speakers. Note that to be able to toggle between the headset and speakers during calls, you must specify a different device for each. Using the default for both results in the same device being assigned to both so toggling does not work.

Output Device (Voice Playback)
Choose a headset, PC-integrated speakers, or external speakers for audio output. Your external playback device is selected by default (if you have one connected).

Input Device (Voice Recording)
Choose a headset microphone, PC-integrated microphone, or external microphone for voice during calls. Your external recording device is selected by default (if you have one connected). You can also choose automatic gain control and test your recording device.

Speakers
Here you can specify what are the output and input devices used for speakers when toggling between the headset and speakers. Note that to be able to toggle between the headset and speakers during calls, you must specify a different device for each. Using the default for both results in the same device being assigned to both so toggling does not work.

Output Device (Voice Playback)
Choose a headset, PC-integrated speakers, or external speakers for audio output. Your external playback device is selected by default (if you have one connected).

Input Device (Voice Recording)
Choose a headset microphone, PC-integrated microphone, or external microphone for voice during calls. Your external recording device is selected by default (if you have one connected). You can also choose automatic gain control and test your recording device.

Ring Device (Alert Signal)
Select the audio device that is played when you receive an incoming call.

Ring Signal
You can select your own ring signal. The same signal is used for both voice and video calls.

You can also select an icon to play a tone for incoming messages. To disable the tone, uncheck the icon. Select a sound event and then click Play to hear the sound. If Alert Info service is used, the network may instruct a certain ringing tone to be played.

30.2.2 Video

Capture Device (Video)
Select a camera that you want to use for video calls. Your external web cam is selected by default (if you have one connected).
## Video Size
Select one of the available sizes. Note, however, that higher sizes require more bandwidth and a more capable central processing unit (CPU).

Click **Test Call** to make a test call to test voice quality.

### 30.3 Incoming Calls
For the list of available call management services for incoming calls, see section **31 Call Settings**. If Alert Info service is used, the network may instruct a certain ringing tone to be played.

### 30.4 Outgoing Calls
For the list of available call management services for outgoing calls, see section **31 Call Settings**. Release 22.7.0 introduced support for the Review feature that you can enable in Preferences → Outgoing calls. Review brings you to the dial pad with the called number pre-populated so that you can modify or review it when you are using the default call type by for instance double-clicking a call history item. In addition, highlight to call and Register to call settings are available in Outgoing calls.

### 30.5 Voice Mail
You can specify various voice mail settings, such as which calls are sent to voice mail, what kinds of notifications you receive when voice mail arrives as well as controlling how fast the voice mail greeting is played and if callers are allowed to leave voice mails. In addition, you can control how callers can end up going to voice mail.

### 30.6 Services
In this release, this section is reserved for presence rules and Hub settings. For more information on presence rules, see section **7.20 Presence Rules and Silent Alerting**.

### 30.7 Extensions
Select how incoming add-in requests are handled, whether they are automatically accepted or not or if incoming requests are allowed at all.

Depending on your service provider configuration, you can also manage extensions using the Communicator Application Programming Interface (API), which is used by third-party applications such as the Outlook Add-in or compatible headsets. You can allow such third-party applications to obtain information from Communicator and enable or disable confirmation pop-up notifications when third-party applications request information from Communicator. You can also choose default behavior to always reject or accept requests from third-party applications and allow or reject individual third-party applications.

Starting with Release 22.0.0, the following logic applies for accepting application requests:

- Every new first-party application is allowed to connect without user interaction.
- Every new third-party application opens a dialog asking for permission to connect. Your response is remembered (both negative and positive responses).

### 30.8 Advanced
The **Advanced** view contains three different subsections:

- **Troubleshooting**
- **Proxy**
Credentials

Troubleshooting

Logging is used for troubleshooting. You may be asked by your service provider to turn on logging and then send a log file directory contents. You can choose basic logging or more detailed logging to be enabled. Detailed logging may consume memory resources so it is not recommended to have it enabled for a long period of time.

You can also clear the logs and open the logging folder as well as enable and disable Google Analytics.

Proxy

Select how to handle HTTP proxies. By default, the system settings are used but you can also choose not to use an HTTP proxy or to use the Communicator (client) proxy settings.

Credentials

Credentials section in the Preferences may be empty depending on your service provider configuration. If the Login window has an embedded configuration URL (see below), the credentials or the configuration URL are not visible.

Configuration URL

If the Device Management configuration URL is available to be viewed, it appears here.

IM Address

If XMPP credentials are available to be viewed, they appear here.

BroadWorks ID

This is the user name that you use to log in.
31 Call Settings

Communicator supports the following service management features allowing supplementary services to be managed using the Preferences and Incoming Calls and Outgoing Calls view available in the Main window left pane by selecting the appropriate sub-view in the drop-down:

- Incoming calls
  - BroadWorks Anywhere
  - BroadWorks Remote Office
  - Forward Calls
  - Do Not Disturb
  - Simultaneous Ring Personal
  - Anonymous Call Rejection
  - Call Waiting
- Voice Messaging
- Outgoing Calls
  - Block My Number (Calling Line Identification Presentation [CLIP]/Calling Line Identification Restriction [CLIR])
  - Automatic Callback
  - Highlight to call
  - Register to call

You can also use the Call Settings with a Main window toolbar on the top of the window, if this feature is enabled. When enabled, this feature allows BroadWorks Anywhere, Do Not Disturb, Remote Office, and Call Forwarding to be managed in the Main window using single clicks or right clicks. From Release 20.2 onwards, the Call Settings toolbar is an icon in the left pane with right-click menus.

31.1 BroadWorks Anywhere

BroadWorks Anywhere allows service providers to offer fixed-mobile convergence (FMC) services today without additional equipment.

BroadWorks Anywhere simplifies communications for on-the-go users and remote users by extending the features of a desk phone to any other fixed or mobile device, regardless of the network or handset manufacturer. Callers dial one number and can reach you on any phone the user chooses. A desk phone, cell phone, and/or a soft phone may ring simultaneously.

Experience voice call continuity with the ability to move live calls from one device to another without hanging up.

Add locations (numbers) that can be used in the service via the Add Number field. Use the Alert all locations simultaneously check box to activate parallel ringing. Click on the “+” icon to see more options.

The Don’t divert check box prevents a call from ending up as a voice mail, which can be problematic in, for example, conference call situations.
Select Answer Confirmation to receive a separate audio prompt when answering a call from that number (location). It may be useful in cases where, for example, mobile numbers are being used to prevent incoming calls going to mobile voice mail since the call will be ended without going to voice mail if the answer confirmation is not provided.

Select the Call Control check box to enable the server platform to provide mid-call services such as Call Transfer and Conferencing for that number (location).

31.2 BroadWorks Remote Office

This service allows the use of any phone as the office phone from a charging and numbering perspective. For instance, a hotel room phone can be used as the office phone.

Enable Remote Office by clicking the service icon and specifying a phone number to be used as the Remote Office number.

31.3 Forward Calls

Enter a number to which your calls should be forwarded. Different variants of Call Forwarding are supported, such as forwarding always, forwarding when busy, and forwarding when you cannot answer or when you are unreachable. In addition, you can specify the number of rings before Call Forwarding is triggered.

31.4 Do Not Disturb

When you activate this service, all calls are typically blocked by the server and are sent to voice mail. Enable this service by enabling the service icon.

31.5 Hide Number

You can hide or display your number when calling or communicating with other parties or contacts. Hide your number by enabling the service icon. To show your number, set this to “Disable”.

31.6 Simultaneous Ring Personal

Add up to ten additional numbers or Session Initiation Protocol Uniform Resource Identifier (SIP URI) addresses that you would like to ring in addition to your primary number when you receive a call. In addition, specify whether you want answer confirmations and if you would like to receive calls when already on another call. This service is an older variant of BroadWorks Anywhere.

31.7 Voice Messaging

You can enable or disable voice messaging in the Preferences and Incoming Calls tab. A number of settings are available:

- Send all calls to voice mail.
- Send busy calls to voice mail.
- Send unanswered calls to voice mail.
- Specify how voice mail messages are handled using an indicator in Communicator or forwarding to email.
- Enable notifications of new messages via email.
- Email a carbon copy of new voice mail.
- Transfer incoming calls to a specified number using “0” DTMF.
Specify how many rings are used before sending an incoming call to voice mail.
Allow/disallow callers to leave a message.

31.8 Anonymous Call Rejection

The Anonymous Call Rejection service allows you to reject calls from parties who have explicitly restricted their identities.

You can enable or disable Anonymous Call Rejection in the Preferences and Incoming Calls tab.

31.9 Automatic Callback

The Automatic Callback (ACB) service allows you to be notified when the previously called busy party becomes idle and is connected without having to redial the phone number.

When you call another party and the call cannot be connected because the line is busy, you are prompted to make an Automatic Callback request (for example, “The line you are calling is busy. Press 1 if you would like to be notified when the line becomes available”).

If you select Automatic Callback, the system monitors the busy party and automatically establishes a call when the busy party becomes available.

You can enable or disable Automatic Callback in the Preferences and Incoming Calls tab.

31.10 Call Waiting

The Call Waiting service allows you to answer a call while already engaged in another call.

You can enable or disable server-based Call Waiting in the Preferences and Outgoing Calls tab. If you disable Call Waiting, the second incoming call is not connected and the caller hears an announcement that the call cannot be completed. Before you answer the first incoming call, the second incoming call will be rejected.
32 Sign Out

Signing out of Communicator sets your status to “Offline” for your contacts and displays the Sign In screen.

32.1 Sign Out of Communicator

To sign out, follow these steps.

**Windows**
1) Click the Communicator logo in the *Main* window title bar.
2) Select *Sign Out*.

**Mac OS**
1) Select *Actions* from the main menu.
2) Select *Sign Out*.

32.2 Exit Application

To exit the application completely, follow these steps.

**Windows and Mac OS**
Close the *Sign In* window.

**Windows**
1) Select the Communicator logo in the *Main* window title bar.
2) Click *Exit* (a keyboard shortcut can also be used).

**Mac OS**
1) Select *Communicator* from the main menu.
2) Select *Quit Communicator* (a keyboard shortcut can also be used).

**NOTE:** Closing the *Main* window (not the *Sign In* window) does not exit the application but rather minimizes the application to the system tray (Dock). This allows you to continue to receive calls and messages without having the Contact List window appearing on the desktop.
33 Multi-Device Support

Communicator supports users with multiple devices, according to the XMPP specifications. This is comprised of several features:

- Chat invitations sent to a user are received on all devices. Once a particular device has been used to answer the chat invitation, subsequent incoming messages only go to that device.

- One can retrieve one’s own presence notifications when another client updates the user’s presence. The client stores this information and updates its own presence so that it is the same as the higher priority status it received, (that is, when the received status update is manual). If the received presence update is not manual, it does not react to the received update; it only notes it.

- Accepting a sharing presence invitation in one client is also recognized by another client, and both clients start receiving presence updates.

- Last sent and received messages are available on all devices when the optional message history feature is in use. All devices should use that feature at the same time to avoid duplicate messages. Your service provider can control how long messages are stored on the server.

- Missed chat badges are synchronized across all own devices when this preview feature is enabled (native Desktop only).

- A new presence subscription made in one client is recognized in another. If the contact declines the “invitation”, there are presence notifications from the server to all of the user’s clients indicating that the subscription was terminated and this information is shown to the user. If the client receives two presence authorization requests from two or more devices for the same user, it only shows one request to the user.

- Removing a contact from the contact list in one device is recognized in another client and the contact list is updated (that is, the contact is removed) in the other client as well.

If a user has many devices, each device has the same status when shown to the end user. In addition, the contacts on the contact list always see the same status with updates shown in the following priority order:

- Busy
- Online
- Away
- Offline

This means, for example, that if one client publishes a Busy status and another client publishes another status, contacts see the user as Busy. Compatible devices such as desk phones are able to show presence in the same way.

Communicator keeps track of its own presence status as well as the status of other devices and deducts the combined presence based on these. For more information, see Appendix E: Multi-Device Presence.

When Connect and Communicator Desktop are used together, the automated presence feature is recommended to be used to have presence shown fully in both clients as Connect does not use XMPP.
When Connect and Communicator Desktop are used together, there are also some rules about location. Mobile applications have a concept of background and foreground mode to save device resources. When Connect comes to the foreground, it updates its location.

The Desktop client does not have separate state for being on foreground; it only detects general usage of the device. The client can be on the background or foreground and based on idle detection it can drop to away. This requires that the computer is not used at all; moving the mouse/using keyboard triggers resuming to available again and it also resets the idle timer. Today, idle detection (or returning from idle) does not trigger location update on Desktop in this release.

When both clients are set to automatic, the last one to publish location “wins”. As mentioned, Connect updates the location in automatic mode when coming to the foreground while Desktop does not have a similar concept. In addition, the last location update, initiated by you, manual or automatic, “wins”.
34 Installation

The installer supports a number of options on Windows (native Desktop only) as follows:

- Agree to the license agreement. Note that two clicks are required to accept the EULA due to legal reasons.
- Run when system starts (can be changed later in Preferences).
- Install Outlook Add-in.
- Install S4B integration
- Modify Windows registry to enable S4B dial pad.
- Create a desktop icon.
- Select destination folder for installation.
- Select the name of the software in the Program menu.
- Launch the client after installation.

When installer has been run on an end user’s behalf by an administrator, the “Run program when system starts” option cannot be changed by that end user.

If you disable startup, for example, in the Task Manager’s Startup list (on Windows 8 and 10) or from msconfig.exe on Windows 7, the change is not reflected in Preferences. The check box remains checked and grey even though the client is not actually started automatically when the system starts.

When Communicator is installed for the first time, you can choose the language if many languages are supported in the installer. The default language is the language of the operating system; if that cannot be found, English is used as the fallback.

Starting with Release 21.5.0 and depending on your service provider settings, the Outlook Add-in installer is bundled together with the Communicator installer.

History is specific to the application name. If upgrading to another Communicator version that has a different application name, the history present in the other version is not available.

Starting with Release 22.3.0, both the Outlook Add-in and S4B integration can be used simultaneously.
35 Uninstallation

The uninstallation procedure is different for Windows and Mac OS.

35.1 Windows

Uninstallation is performed by launching the Windows uninstaller via the Start menu or by using the Windows “Remove programs” view inside the Control Panel. Windows uninstallation does not require you to select any options. The language used for the Windows Start menu string “Uninstall” is taken from the language chosen when installing the client. This string cannot be changed after installation.

All files are deleted at uninstallation, except for the following files:

- Registry entries
- Account files are only deleted when explicitly allowed by the end user on Windows.

Note that as a result, some USB headset add-in files may also get deleted. For a workaround, see section 38 Troubleshooting.

35.2 Mac OS

Uninstalling is performed by simply dragging the application folder from the Applications directory to the trash can; however, account files are not deleted. If you want to remove account files, they must be manually deleted. These are the file locations for the account directories. The following locations apply for all account directories:

For branded clients:

```
/Users/<USERNAME>/Library/Application Support/<company_name>/<application_name>
```

For the reference client:

```
/Users/<USERNAME>/Library/Application Support/BroadSoft/Communicator
```
36 Version Control and Automatic Upgrade

Depending on your service provider settings, you may receive a notification to upgrade Communicator to a newer version. Starting with Release 22.3.0, this upgrade may take place automatically after you accept it in a separate dialog. In older versions, you must manually install the downloaded upgraded version.

The upgrade may be recommended or mandatory. If it is mandatory, then Communicator does not start before the upgrade is done.

In automatic upgrade dialog you can choose between:

- Remind Me Later – You’ll get a new pop-up at next login.
- Skip This Version – You won’t get a new pop-up for this version, but the next or if you manually check for updates in the menu.
- Update Now – upgrade is done immediately.

If you do not have administrator rights on your computer, the automatic upgrade typically does not work (your service provider may have hidden automatic upgrade UI elements for this reason). An exception is when a login attempt fails because the mandatory upgrade is missing.

In general, there are two cases when automatic upgrade popups are shown to you when you do not have administrator rights:

- If the update is mandatory.

OR

- If you installed Communicator without an Outlook or S4B Add-in and you also have access rights to write in the installation directory.
37 System Requirements

System requirements are as follows on native Desktop:

- Operating system: Mac OS 10.11 El Capitan, Mac OS 10.12 Sierra, Mac OS 10.13 High Sierra, Mac OS 10.14 Mojave, Windows 7 SP1, Windows 8/8.1, or Windows 10 (Classical view only).
- The installation footprint is approximately 125 megabytes (MB) on Mac OS and 215 MB on Windows.
- For voice calls, a sound card, speakers, and a microphone or a headset are required.
- For video calls, a web cam is required.

Minimum system requirements for respective operating systems need to be fulfilled, with the following additions:

- A minimum of 2 GB random access memory (RAM) is required.
- A minimum 1.5 GHz CPU is recommended. A dual core CPU is recommended for video calls at a minimum.
- Open Graphics Library (OpenGL) 1.5 or higher is recommended.

For high definition (HD) video, the following is recommended:

- HD camera
- HD resolution support in display
- Quad Core x86 or equivalent at a minimum
- 4 GB RAM

VDI environments are not supported.
38 Troubleshooting

Why are my Emojis showing as black boxes?
The Segoe UI font is required for the Emojis to appear correctly. For more information to install the Segoe UI font, see the following article:


Why did I lose chat history after an upgrade to a renamed Communicator?
When installing a Communicator version that has a different application name, the history is specific to that application name. If the application name remains the same in the upgrade, the previous history is available.

Why can’t I chat with contacts from Yahoo?
Chatting with users in other domains is possible, but depends on the domain. For instance, BroadCloud supports Google federation but not Yahoo. However, group chat is not supported in Google federation, so the group chat option with those contacts is shown in grey.

Why can’t I change the avatar?
Double-clicking the avatar should open a File Explorer view to select a file. If your XMPP connection is lost, changing the avatar does not succeed. A lost XMPP connection is indicated in the Main window’s top notification area.

My contacts are all offline and my client’s status bar says “XMPP unavailable”. What does this mean?
It means that the XMPP connectivity has been lost for chat, as well as for presence; however, you can still make calls. You should contact your service provider.

Why am I offline?
If you have selected “Offline” status, you are shown as offline to others. Another possibility is that you may have lost your Internet connection. In this case, the client does not log out, but rather enters an offline mode where a contact list is available but communication is not possible.

Why can’t I have more video resolutions available?
You can choose your video resolution from Preferences and the Video tab. Your selection is used by default for future video calls. The available resolutions are automatically presented based on your camera.

Why can’t I change my user name and password?
User name and password editing is not supported in the client. To edit your user name or password, contact your service provider. The exception is login password expiry. When it expires, you can change the password in a separate dialog window.

In Preferences, the client only supports changing credentials when enabled by the service provider. Desktop sharing credentials may also be changed, depending on your service provider settings.
Why does my all day calendar entry not trigger Busy – In Meeting presence status?
Not all meetings trigger a presence change to Busy – In Meeting.
To trigger the presence update, the meeting must be in the Show me as busy state.

Why aren't all my group chat messages saved?
Only the newest chat room messages are stored on the server, but never for My Room for security reasons. Starting from Release 21.3.0, when the optional (Preview mode in Release 21.3.0 and fully supported in Release 21.4.0) message history feature is enabled by your service provider, messages sent from other devices are also shown.

Why aren't all my chat messages available in my other devices?
All one-on-one and group chat messages are saved, but only locally, so they are not necessarily available in your other devices. Incoming messages are sent to all devices; however, the ones that you send are only stored in the device that you are using to send the message. Starting from Release 21.3.0, when the optional (Preview mode in Release 21.3.0) message history feature is enabled by your service provider, messages sent from other devices are also shown.

Why can't I change the XMPP address of a contact?
This is not supported in this release. However, you can delete the contact and add a new one.

Why does my location show an incorrect address?
It is done based on the public IP address that the machine is using. The IP address is mapped to a physical location. BroadSoft is working with the mapping provider to improve the accuracy of the location. You can also manually change the location by clicking the avatar and changing the location icon.

Why can't I start desktop sharing?
To share your desktop, you need to have valid credentials, either by manually entering desktop sharing credentials in the Preferences → Credentials window, or by using auto-provisioning to enable the desktop sharing menu items and icons. However, you can participate in desktop sharing sessions even without any sharing credentials. Your service provider settings dictate if auto-provisioning is enabled or not.

Why can't My Room participants share the desktop?
Only the owner of the room can share the desktop before Release 21.2.0. Starting in Release 21.2.0, participants can also share when enabled by the service provider. This applies to both My Room and ad hoc sessions.

I have a USB headset and the Call Control features are not working. Is there anything special I need to do to enable Call Control support?
In order to use headsets on Windows (not supported on Mac OS), several steps are needed:

1) When the client is started, you must accept the API connection request from the connector/add-in device.

2) Additionally, your client must have the feature enabled by your service provider.

3) If your USB headset uses its own add-in, the standard HID Add-in from BroadSoft must be disabled, as both cannot be used at the same time. In addition, you must have “Allow 3rd party extensions” check box checked in Preferences → Extensions tab.
4) After upgrading UC-One, some USB headset add-ins may get deleted causing call control to not work and the add-in to not be visible in Preferences. As a workaround, repairing/re-installing the add-in software corrects this.

**Why is the Outlook Add-in disabled?**

If the context menu does not show Add-in menu items, this could be due to the Outlook Add-in disabled by Outlook for slow loading. This happens primarily in Outlook 2013. In such cases, enable this add-in by selecting the Outlook menu → File → Info → Manage Add-Ins → Communication Add-in → Always enable this add-in from the displayed menu (as shown in the following figure).

![Figure 12 Outlook Account Information – Add-in Disabled](image)

**Why is presence not showing in the Outlook Add-in?**

If the presence indicator icon is not shown in Outlook, verify any of the following software is installed:

- Microsoft Office Communicator (OCS)
- Microsoft Lync/S4B
- Skype version 6.1 or above

Uninstall each one found and restart Outlook and the Communicator client.
NOTE: During Office/Outlook 2013 installation, the installer installs Microsoft Lync by default. You must uncheck Microsoft Lync (as shown in the following figure) and then proceed with the installation.

![Microsoft Office Installation Example](image)

**Figure 13 Microsoft Office Installation Example**

**How do I disable/enable the Outlook Add-In from Communicator Preferences view?**

To enable/disable Outlook contact presence status (5.1 Presence in Outlook), from the Communicator Preference page, the “UC-One Outlook Add-in, Gateway process” check box option must be checked/unchecked.

![Communicator Preference Page](image)

**Figure 14 Communicator Preference Page**

To enable/disable the Outlook context menu related to the add-in, from the Communicator Preference page, the “UC-One Outlook Add-in” check box option must be checked/unchecked.

![Communicator Preference Page](image)

**Figure 15 Communicator Preference Page**
Why are Outlook Add-in IM buttons sometimes greyed out in the quick contact page, even though the user is logged in?

Sometimes IM buttons are greyed out on the contact page. When mouse over it, it shows the message "To use this feature, sign in to an instant messaging program".

![Figure 16  Outlook Add-in IM Buttons Issue](image)

This seems to be a Microsoft issue, and the workaround to solve is to restart Outlook.
## Appendix A: Keyboard Shortcuts for Desktop

The following table lists the currently supported keyboard shortcuts (native Desktop only). You can use these keyboard shortcuts to quickly perform frequently used actions. The characters used are lower case. The shortcuts are also indicated in the accessibility menus.

<table>
<thead>
<tr>
<th>Shortcut for Windows</th>
<th>Shortcut for Mac</th>
<th>What it does</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL-Q</td>
<td>Cmd-Q</td>
<td>This quits the application.</td>
</tr>
<tr>
<td>Alt+F4</td>
<td>Cmd-W</td>
<td>This closes the selected window (except for a contact card and the About window).</td>
</tr>
<tr>
<td>CTRL+C</td>
<td>Cmd-C</td>
<td>This copies selected text from Communicator to the clipboard.</td>
</tr>
<tr>
<td>CTRL+V</td>
<td>Cmd-V</td>
<td>This pastes text from the clipboard to the location selected using the cursor in Communicator.</td>
</tr>
<tr>
<td>CTRL-X</td>
<td>Cmd-X</td>
<td>This cuts the selected text to clipboard.</td>
</tr>
<tr>
<td>Enter</td>
<td>Enter</td>
<td>When in the Communications window, this sends a chat message (if the Chat view is visible). When in the contact list, this opens a chat with the selected contact. When in the Communications History, this opens a communications session with the contact or address related to the selected item. This opens a chat if the item was chat and a call if the item was a call.</td>
</tr>
<tr>
<td>-</td>
<td>Cmd-,</td>
<td>This opens Preferences.</td>
</tr>
<tr>
<td>F1</td>
<td>Cmd-?</td>
<td>This opens Help.</td>
</tr>
<tr>
<td>CTRL+A</td>
<td>Cmd-A</td>
<td>This selects all text in the Chat view.</td>
</tr>
<tr>
<td>-</td>
<td>Cmd-H</td>
<td>This hides Communicator.</td>
</tr>
<tr>
<td>-</td>
<td>Alt-Cmd-H</td>
<td>This hides other windows other than Communicator.</td>
</tr>
<tr>
<td>CTRL-N</td>
<td>Cmd-N</td>
<td>This opens the Add Contact window.</td>
</tr>
<tr>
<td>Shift-CTRL-N</td>
<td>Shift-Cmd-N</td>
<td>This opens the Add Group window.</td>
</tr>
<tr>
<td>CTRL -1</td>
<td>Cmd-1</td>
<td>When a contact is selected, this opens a chat session with the contact.</td>
</tr>
<tr>
<td>CTRL -2</td>
<td>Cmd-2</td>
<td>When a contact is selected, this calls the contact with audio.</td>
</tr>
<tr>
<td>CTRL -3</td>
<td>Cmd-3</td>
<td>When a contact is selected, this calls the contact using call from phone.</td>
</tr>
<tr>
<td>CTRL -4</td>
<td>Cmd-4</td>
<td>When a contact is selected, this calls the contact with video.</td>
</tr>
<tr>
<td>CTRL -5</td>
<td>Cmd-5</td>
<td>When a contact is selected, this joins their room.</td>
</tr>
<tr>
<td>CTRL -6</td>
<td>Cmd-6</td>
<td>When a contact is selected, this opens an email-sending window using the default email client.</td>
</tr>
<tr>
<td>CTRL -I</td>
<td>Cmd-I</td>
<td>When a contact is selected, this opens the contact card for the contact.</td>
</tr>
<tr>
<td>Shift-CTRL-F</td>
<td>Shift-Cmd-F</td>
<td>When a contact is selected, this makes the contact a favorite.</td>
</tr>
<tr>
<td>CTRL-delete</td>
<td>Cmd-delete</td>
<td>This deletes the selected contact.</td>
</tr>
<tr>
<td>Shortcut for Windows</td>
<td>Shortcut for Mac</td>
<td>What it does</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------</td>
<td>--------------</td>
</tr>
<tr>
<td>CTRL-arrow down</td>
<td>Cmd-arrow down</td>
<td>This decreases the volume.</td>
</tr>
<tr>
<td>CTRL-arrow up</td>
<td>Cmd-arrow up</td>
<td>This increases the volume.</td>
</tr>
<tr>
<td>CTRL-space</td>
<td>CTRL-space</td>
<td>This mutes the client (while in a call).</td>
</tr>
<tr>
<td>CTRL-D</td>
<td>Cmd-D</td>
<td>This turns on the Do Not Disturb service.</td>
</tr>
<tr>
<td>CTRL-P</td>
<td>Cmd-P</td>
<td>This pulls an ongoing call from your other device to Communicator.</td>
</tr>
<tr>
<td>Alt-shift-CTRL-P</td>
<td>Alt-shift-Cmd-P</td>
<td>This retrieves your parked call.</td>
</tr>
<tr>
<td>-</td>
<td>Alt-Cmd-2</td>
<td>This calls your voice mail with audio.</td>
</tr>
<tr>
<td>-</td>
<td>Alt-Cmd-3</td>
<td>This calls your voice mail with audio using call from phone.</td>
</tr>
<tr>
<td>-</td>
<td>Alt-Cmd-4</td>
<td>This calls your voice mail with video.</td>
</tr>
<tr>
<td>Shift-CTRL-R</td>
<td>Shift-Cmd-R</td>
<td>This opens your My Room.</td>
</tr>
<tr>
<td>CTRL-M</td>
<td>Cmd-M</td>
<td>This minimizes the window on Mac OS. On Windows, it only is used for the Team Telephony window.</td>
</tr>
<tr>
<td>CTRL-T</td>
<td>Cmd-T</td>
<td>This enables always on top.</td>
</tr>
<tr>
<td>-</td>
<td>Shift-Cmd-M</td>
<td>This opens the Main window.</td>
</tr>
<tr>
<td>Shift-CTRL-C</td>
<td>Shift-Cmd-C</td>
<td>This opens contacts.</td>
</tr>
<tr>
<td>Shift-CTRL-F2</td>
<td>Shift-Cmd-F2</td>
<td>This opens call history.</td>
</tr>
<tr>
<td>Shift-CTRL-F1</td>
<td>Shift-Cmd-F1</td>
<td>This opens chat history.</td>
</tr>
<tr>
<td>Shift-CTRL-F3</td>
<td>Shift-Cmd-F3</td>
<td>This opens visual voice mail.</td>
</tr>
<tr>
<td>Shift-CTRL-D</td>
<td>Shift-Cmd-D</td>
<td>This opens the dial pad view.</td>
</tr>
<tr>
<td>Shift-CTRL-W</td>
<td>Shift-Cmd-W</td>
<td>This opens the web button view.</td>
</tr>
</tbody>
</table>
Appendix B: Guest Client Usage

This section provides more hands-on information about guest client usage.

1) Right-click on the My Room icon to copy the guest join link and send it to a guest via email or other means. You can also use the Copy Guest Link feature in My Room.

![Copy Guest Join Link Menu Option](image1)

Figure 17 Copy Guest Join Link Menu Option

2) The guest can open the link in one of the supported browsers, enter their name and password, and then click Join Room.

![Login Screen for Join Room](image2)

Figure 18 Login Screen for Join Room
3) Once you click on **Join Room**, you see a notification on your My Room (as shown in the following figure).

![Room Info](image.png)

Figure 19  My Room Icon – Guest Request Badge

4) Open your My Room and accept the guest request.
5) The guest is allowed into your room and can now participate in multi-user chat with other participants in the room (as shown in the following figure from a browser).
If your service provider has enabled WebRTC support, then the guest can join the audio/video portion of the session by clicking on the audio or video button. This feature is only available on certain browsers and the user must grant access to their camera and microphone by clicking **Allow**.

The guest can switch between audio and video mode by clicking on the video icon. They can also mute and end the call by clicking on the mute and end call icons respectively.

![My Room Window Icons](image)

Figure 22  My Room Window Icons

The guest can show or hide their self-view by clicking on the icon in the top left corner of the video.

6) You can start your desktop share from the Desktop client and the guest then sees it. The video call is resized and moved to the top left.

![My Room – Desktop Share with Video Call](image)

Figure 23  My Room – Desktop Share with Video Call

7) The guest can also request the conference bridge to call them by entering a phone number and clicking on the **CALL ME** button. The Call Me Now feature must be enabled by your service provider for this to be available.

The guest can also manually call the conference bridge directly by using the provided dial-in information.
Appendix C: Skype for Business Integration

This section provides more hands-on information about Skype for Business (S4B) integration usage.

The typical startup procedure is as follows (reversing the order in which S4B and Communicator are started should also work):

1) Start S4B.

2) Start Communicator. You can have it minimized or in the foreground although minimizing is recommended. Your service provider may also choose an automatic “Minimize after login” feature that automatically minimizes Communicator after login.

By default, when making a PSTN call from S4B while UC-One is minimized, UC-One comes to the foreground for the duration the call and is then auto-minimized after call except in the following cases:

- Chat has been used during the call (chat may continue)
- Window size has been changed
- Active view has been changed (for example, from contacts to dial pad)

UC-One does not minimize after an incoming PSTN call to UC-One unless configured to do so by your service provider. In addition, by default, if UC-One is in the task bar before the call, then it does not auto-minimize.

When auto-minimizing after call is enabled by your service provider, Communicator is sent to the background “closed”, so that you can only access it through the system tray. If Communicator is either minimized or in the background when call is triggered outside of Communicator, or a call is answered with Communicator, upon terminating the last call, Communicator is sent to the background.

All other communications related to that call, such as chat, are terminated and the tab/communications window is closed prior to sending Communicator to the background. This happens regardless if you are engaged in ongoing chats, share, or other activities inside or outside the last call that terminated.

If Communicator is brought to the foreground manually this new behavior does not apply.

The original intended use case for S4B integration was to use S4B for presence and chat and on-net (VoIP) calls while Communicator would be used for off-net calls with presence and chat turned off. However, many deployments keep the full presence and chat functionality of Communicator. Communicator supports presence synchronization between S4B and Communicator for most presence statuses.

The following sections describe the ways to make various kinds of calls.

On-Net Calling

To make an on-net call:

1) Select a S4B contact and click the call button. Alternatively, right-click a contact and select an on-net number.

2) Both the S4B main window and communications window are visible (as shown in the following figures).
Off-Net Calling

Off-net calling must be done using a custom menu “Call with <application name>”.

Your service provider can configure Communicator to make the call instead in these cases.

To make an off-net call:

1) Select a contact, right-click and select “Call with <application name>” menu. Use the submenu to select the desired number.
2) Communicator attempts to make the call instead of S4B. Both the S4B main window and Communicator *Communications* window are visible.

![Making an Off-Net Call](image1)

Figure 26 Making an Off-Net Call

![Ongoing Off-Net Call](image2)

Figure 27 Ongoing Off-Net Call

After the call, UC-One typically is minimized unless there is, for example, chat ongoing.

**Presence Synchronization**

When Communicator is configured to have full presence functionality and to also act in S4B integration mode, making a call in Communicator may automatically change Communicator presence to *Busy – In Call*. In this case, a similar presence status is automatically selected on the S4B side and vice versa.
The same principle also applies to other presence statuses. Changing presence on the S4B side is detected by Communicator and a similar presence state is automatically shown on the Communicator side. Note that the different presence statuses used in S4B and Communicator are not 100% the same so an exact mapping is not possible. However, a status variant is matched to a similar status variant on the other client. For example, a busy status variant would be matched to a busy status variant.
Appendix D: Configure USB Headsets

This section provides more information on configuring USB devices to function with Communicator. Note that some headset manufacturers have built their own add-ins for UC-One, for instance, Jabra on Windows. In this case, the standard HID Add-Ins cannot be used at the same time. You can enable and disable add-ins in the Preferences → Extensions view.

In general on Windows, if “Default Communication Device” is defined in Windows settings, it is selected over the “Default Device” by Communicator for calls when several audio devices are available (for example, USB headset and the integrated audio device on the PC). However, when using headsets, you can select a separate device than the headset for alerting incoming calls.

The following examples provide more information on how to define a default communications device when a USB headset is available on the PC.

It is recommended to select “Use Default” in the Media tab of Communicator Preferences for both input and output devices (as shown in the following figure).
Figure 28  Preferences Window
1) To define the default communications device, make sure that the Sound settings in Windows pertaining to “Recording” and “Playback” devices are correctly configured. From the Sound applet, select the Playback tab.

![Sound Window – Playback Tab](image)

In this example, the user has a Plantronics BT300M (the USB dongle accompanying a Voyager Legend UC) connected to their PC.
2) Click **Headset Earphone** to highlight the device and click on the drop-down arrow next to the **Set Default** button.

![Sound Window – Playback Tab – Set Default](image)

*Figure 30  Sound Window – Playback Tab – Set Default*
3) Select *Default Communication Device*. The following screen is displayed.

![Sound Window - Playback Tab - Default Set](image)

Figure 31 Sound Window – Playback Tab – Default Set
4) Next, click the **Recording** tab.

![Sound Window – Recording Tab](image)

*Figure 32  Sound Window – Recording Tab*
5) Again, click on Headset Microphone, which represents the connected Plantronics BT300M device, and click on the drop-down arrow next to the Set Default button.

Figure 33  Sound Window – Recording Tab – Set Default
6) Select *Default Communication Device*. 

![Sound Window – Recording Tab – Default Set](image)

Figure 34  Sound Window – Recording Tab – Default Set

7) Click **OK** to save the changes. The *Sound* window is dismissed and your device is now ready to be used by Communicator.
Appendix E: Multi-Device Presence

This section provides a table describing the presence state changes based on the presence state that Communicator has as well as the presence status of other devices that the same user has active. There is a distinction between what is shown in the UI and what is the internal presence status of the Communicator client since the design is to show the same own presence in the UI of all own online devices. The following table is applicable from Release 21.3.0 to 21.6.0 when the presence aggregation feature is not used. Earlier releases have slightly different behavior in some cases. The table describes presence state changes when steps 1 through 6 are executed in order, starting from step 1 and continuing through to step 6.

<table>
<thead>
<tr>
<th>Presence published by IOS</th>
<th>Presence published by Desktop</th>
<th>Action by IOS Communicator</th>
<th>Initial Status</th>
<th>Result</th>
<th>Initial Status</th>
<th>Result</th>
<th>Initial Status of User A</th>
<th>User A status after action</th>
</tr>
</thead>
<tbody>
<tr>
<td>away :30</td>
<td>away :30</td>
<td>Step1 Try to change iphone status from Available to Away</td>
<td>Available</td>
<td>Away</td>
<td>Available</td>
<td>Away</td>
<td>Available</td>
<td>Away</td>
</tr>
<tr>
<td>dnd 100</td>
<td>dnd 100</td>
<td>Step2 Try to change iphone status from Away to Busy</td>
<td>Away</td>
<td>Busy</td>
<td>Away</td>
<td>Busy</td>
<td>Away</td>
<td>Busy</td>
</tr>
<tr>
<td>unavailable</td>
<td>none</td>
<td>Step3 Try to change iphone status from Busy to offline</td>
<td>Busy</td>
<td>offline</td>
<td>Busy</td>
<td>Busy</td>
<td>Busy</td>
<td>Busy</td>
</tr>
<tr>
<td>-10</td>
<td>away :30 and then dnd +100 when typing/mouse activity on Pc</td>
<td>Step4 Try to change iphone status from offline to Available</td>
<td>Offline</td>
<td>Busy</td>
<td>Busy</td>
<td>Busy</td>
<td>Busy</td>
<td>Busy</td>
</tr>
<tr>
<td>unavailable</td>
<td>none</td>
<td>Step5 Try to change iphone status from Available to Offline</td>
<td>Busy</td>
<td>Offline</td>
<td>Busy</td>
<td>Busy</td>
<td>Busy</td>
<td>Busy</td>
</tr>
<tr>
<td>-10</td>
<td>away :30 and then dnd +100 when typing/mouse activity on Pc</td>
<td>Step6 Try to change iphone status from offline to available</td>
<td>Offline</td>
<td>Busy</td>
<td>Busy</td>
<td>Busy</td>
<td>Busy</td>
<td>Busy</td>
</tr>
</tbody>
</table>

The previous scenario happens when typing or mouse movement occurs on the desktop machine in steps 4 and 6. If this is not done, then the away status would be the desktop's "own" presence and the table would look as follows (same states in the beginning and different ones marked in green).

<table>
<thead>
<tr>
<th>Presence published by IOS</th>
<th>Presence published by Desktop</th>
<th>Action by IOS Communicator</th>
<th>Initial Status</th>
<th>Result</th>
<th>Initial Status</th>
<th>Result</th>
<th>Initial Status of User A</th>
<th>User A status after action</th>
</tr>
</thead>
<tbody>
<tr>
<td>away :30</td>
<td>away :30</td>
<td>Step1 Try to change iphone status from Available to Away</td>
<td>Available</td>
<td>Away</td>
<td>Available</td>
<td>Away</td>
<td>Available</td>
<td>Away</td>
</tr>
<tr>
<td>dnd 100</td>
<td>dnd 100</td>
<td>Step2 Try to change iphone status from Away to Busy</td>
<td>Away</td>
<td>Busy</td>
<td>Away</td>
<td>Busy</td>
<td>Away</td>
<td>Busy</td>
</tr>
<tr>
<td>unavailable</td>
<td>none</td>
<td>Step3 Try to change iphone status from Busy to offline</td>
<td>Busy</td>
<td>offline</td>
<td>Busy</td>
<td>Busy</td>
<td>Busy</td>
<td>Busy</td>
</tr>
<tr>
<td>-10</td>
<td>away :30 and then dnd +100 when typing/mouse activity on Pc</td>
<td>Step4 Try to change iphone status from offline to Available</td>
<td>Offline</td>
<td>Available on Mobile</td>
<td>Busy</td>
<td>Available on Mobile</td>
<td>Busy</td>
<td>Available on Mobile</td>
</tr>
<tr>
<td>unavailable</td>
<td>none</td>
<td>Step5 Try to change iphone status from Available to Offline</td>
<td>Available on Mobile</td>
<td>offline</td>
<td>Available on Mobile</td>
<td>Away</td>
<td>Available on Mobile</td>
<td>Away</td>
</tr>
<tr>
<td>-10</td>
<td>away :30 and then dnd +100 when typing/mouse activity on Pc</td>
<td>Step6 Try to change iphone status from offline to available</td>
<td>Offline</td>
<td>Available on Mobile</td>
<td>Away</td>
<td>Available on Mobile</td>
<td>Away</td>
<td>Available on Mobile</td>
</tr>
</tbody>
</table>
Appendix F: Third-Party Software and Copyright

The following third-party software is used in Communicator.

**Chromium**

Copyright (c) 2013 The Chromium Authors. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. * Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. * Neither the name of Google Inc. nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

**WebRTC**

Copyright (c) 2011, The WebRTC project authors. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Google nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

OpenH264
Copyright (c) 2013, Cisco Systems. All rights reserved.
OpenH264 License: https://github.com/cisco/openh264/blob/master/LICENSE

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Blowfish
Based on a C implementation of the Blowfish algorithm by Paul Kocher

UUID - RFC4412

/*
** Copyright (c) 1990 - 1993, 1996 Open Software Foundation, Inc.
** Copyright (c) 1989 by Hewlett-Packard Company, Palo Alto, Ca. 
** Digital Equipment Corporation, Maynard, Mass.
** Copyright (c) 1998 Microsoft.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the ZETETIC LLC nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY ZETETIC LLC "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL ZETETIC LLC BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

**Lesser General Public License (LGPL)**

The following third-party libraries are in use based on LGPL license.

This software uses Qt libraries licensed under the GNU Lesser General Public License (LGPL) 2.1.

Qjson – Copyright 2012 – Flavio Castelli
QXmpp – Copyright 2008-2011 The QXmpp developers
QCA – Copyright 2003-2007 Justin Karneges justin@affinix.com. Copyright 2004-2006 Brad Hards bradh@frogmouth.net


LGPL license is also available locally with this software, at the installation directory.

**BSD license**

The following software is used based on BSD license:

OpenSSL - Copyright 1998-2011. The OpenSSL Project.

Breakpad - Copyright 1998, Regents of the University of California
Breakpad license available at [http://opensource.org/licenses/BSD-3-Clause](http://opensource.org/licenses/BSD-3-Clause).

Stackwalker - Copyright 2009, Jochen Kalmbach

**Apache license 2.0**

The following third-party libraries are using Apache license 2.0:

Log4cxx - Copyright 2012 Apache Software Foundation.
Non-restrictive license
The following third-party library is used based on its own non-restrictive license:

OpenLDAP - Copyright 2013, OpenLDAP Foundation.

OpenLDAP license is available online for review at http://www.openldap.org/software/release/license.html.

OpenLDAP license is also available locally with this software at the installation directory.

Free software
The following free software is only used when third-party software is using the Communicator API via LGPL, MIT, BSD, or another license:

Tufao (LGPLv2.1) – Copyright 2012 Vinicius dos Santos Oliveira vini.ipsmaker@gmail.com
Libcurl – Copyright 1996 - 2013, Daniel Stenberg, daniel@haxx.se
License available at http://curl.haxx.se/docs/copyright.html.

Tinythread++ - Copyright 2012 Marcus Geelnard

Picojson – Copyright 2009-2010 Cybozu Labs, Inc. Copyright 2011 Kazuho Oku
License available at https://github.com/kazuho/picojson/blob/master/LICENSE.

Easywsclient – Copyright 2012, 2013 dhbaird@gmail.com
License available at https://github.com/dhbaird/easywsclient/blob/master/COPYING.

The Qt Toolkit is Copyright (C) 2015 The Qt Company Ltd.
Contact: http://www.qt.io/licensing/

You may use, distribute and copy the Qt GUI Toolkit under the terms of GNU Lesser General Public License version 3.

This license makes reference to version 3 of the GNU General Public License.


EmojiOne
Emoji artwork provided by EmojiOne.
http://emojione.com
Appendix G: Acronyms and Abbreviations

This section lists the acronyms and abbreviations found in this document. The acronyms and abbreviations are listed in alphabetical order along with their meanings.

ACB  Automatic Callback
ACD  Automatic Call Distribution
API  Application Programming Interface
CPU  Central Processing Unit
DND  Do Not Disturb
DTMF  Dual-Tone Multi-Frequency
ECACS  Emergency Call Address Change Service
EULA  End-User License Agreement
FAC  Feature Access Code
FAQ  Frequently Asked Question
FIPS  Federal Information Processing Standard
FMC  Fixed-mobile Convergence
GUI  Graphical User Interface
GW  Gateway
HD  High Definition
HID  Human Interface Device
IdP  Identity Provider
IM  Instant Message
IM&P  Instant Messaging and Presence
IP  Internet Protocol
LDAP  Lightweight Directory Access Protocol
LGPL  Lesser General Public License
MWI  Message Waiting Indication
PIV  Personal Identity Verification
RAM  Random Access Memory
S4B  Skype for Business
SAML  Security Assertion Markup Language
SIP  Session Initiation Protocol
SSO  Single Sign-On
UC  Unified Communications
UI  User Interface
URL  Uniform Resource Locator
UVS  BroadWorks Video Server
<table>
<thead>
<tr>
<th>Acronym</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VDI</td>
<td>Virtual Desktop Infrastructure</td>
</tr>
<tr>
<td>VoIP</td>
<td>Voice over IP</td>
</tr>
<tr>
<td>WebRTC</td>
<td>Web Real-Time Communication</td>
</tr>
<tr>
<td>XMPP</td>
<td>Extensible Messaging and Presence Protocol</td>
</tr>
<tr>
<td>Xsi</td>
<td>Xtended Services Interface</td>
</tr>
</tbody>
</table>